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• Office 2004 for Macintosh: The Missing Manual by Mark H. Walker, Franklin Tessler, 
and Paul Berkowitz 

• iPhone: The Missing Manual by David Pogue 

• Photoshop CS3: The Missing Manual by David Pogue 

For Starters 
The "For Starters" books contain just the most essential information from their larger 
counterparts-in larger type, with a more spacious layout, and none of those advanced 
sidebars. Recent titles include: 

• Windows Vista for Starters: The Missing Manual by David Pogue 

• Windows XP for Starters: The Missing Manual by David Pogue 

• Access 2007 for Starters: The Missing Manual by Matthew MacDonald 

• Excel 2007 for Starters: The Missing Manual by Matthew MacDonald 

• Quicken 2006 for Starters: The Missing Manual by Bonnie Biafore 

• Word 2007 for Starters: The Missing Manual by Chris Grover 

• Power Point 2007 for Starters: The Missing Manual by Emily A. Vander Veer 

• Mac OS X for Starters: The Missing Manual by David Pogue 
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Introduction 

L et's face it: in the last few years, all the fun went out of using a. PC. Viruses, spy­
ware, spam, pop-ups, and other Web nastiness had turned us all into cowering 
novice system administrators, spending far too much time trying to shore up 

our computers rather than using them to get things done. 

Why on earth didn't Microsoft do something? 

Of course, now we know: Microsoft was doing something. It just took five years to 
finish doing it. 

That something was Windows Vista, a new version (well, OK, five or seven versions) 
that came with every porthole sealed, every backdoor nailed shut, and every design 
flaw reworked by a newly security-conscious squad of Microsofties. 

Microsoft won't go as far as saying that Vista is invulnerable; nothing with 50 million 
lines of code could possibly be bulletproof. The bad guys are certainly going to do their 
best. 

But it's certainly safe to say that Vista is by far the most secure Windows yet, and that 
the sociopaths of the Internet will have a much, much harder time. 

That's not all Microsoft accomplished in writing Vista, though. As you'll notice within 
the first 5 seconds, the company also gave the operating system a total overhaul, both 
in its capabilities and its look. Vista is the best-looking version of Windows ever. 
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What's New in Windows Vista 
The real question is, what isn't new? 

Windows Vista is a huge overhaul. Both the guts and the window dressing have been 
completely renovated. Here's a top-level executive summary. 

Security 
For five years, through multiple restarts and reshufflings of the Vista project, Microsoft 
became obsessed with making Windows more secure-and there are few who'd say 
that its obsession was misplaced. 

You could fill several books with nothing but information about the security 
features-a lot of them are so technical, they'd make your eyes glaze over-but here's 
a sampling. 

• User Account Control may look to you like a completely unnecessary annoyance: 
a dialog box that pops up whenever you try to install a program or adjust a PC­
wide setting, requesting that you type your password. Over, and over, and over. 

In fact, UAC is one of Vista's most important new protection features, modeled 
on something similar in Mac OS X and Unix. It means that viruses can no longer 
make changes to your system without your knowing about it. You'll see one of 
these dialog boxes, and if you aren't the one trying to make the change, you'll click 
Cancel instead of Continue. 

· The Security Center offers one-stop shopping for several important security features: 
the firewall (protects your PC from incoming signals from hackers), Automatic 
Updates (bug fixes and security patches beamed to you from Microsoft), virus and 
spyware protection, Internet security settings, and User Account Control. 

• Windows Defender is a new program that protects your PC from spyware (down­
loads from the Internet that, unbeknownst to you, send information back to their 
creators or hijack your Web browser). 

• Protected Mode is a new feature of Internet Explorer that keeps hackers from 
attacking it. 

• A phishing filter alerts you when you're about to visit a fake bank or eBay Web 
page to "update your account settings." In fact, you're probably being scammed. 
You've been sent a bogus alert email that, in fact, is a trap set by scammers hoping 
to steal your account and credit-card information. 

• Service Hardening prevents invisible background programs from tampering with 
the system files, the Registry, or the network. 

• Corporate features let network administrators exert a lot more control over what 
the worker bees are doing. Your company's network geeks, for example, can institute 
a group policy (a corporate network "rule") that bans the use of USB flash drives, 
to prevent viruses from coming in or important documents from going out. They 
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can also prevent any"unsafe" PC ( one whose Microsoft patches and virus program 
aren't up to date) from even connecting to the network. 

• Parental Controls lets you, the wise parent, restrict children's use of the PC. You can 
dictate what Web sites they can visit, which people they correspond with online, 
and even what times of day they can use the machine. 

• BitLocker Drive Encryption encrypts your entire hard drive, so that even if 
determined hackers steal your laptop and extract the drive, they'll get no useful 
information off it. 

·Anew backup program offers two modes: backup by file type (all your photos, 
music, and Office files, for example) or complete PC backup (all your programs, 
system files, the works). 

And remember System Restore, the life-saving troubleshooting tool that lets you 
rewind your PC to a time when it was working properly? A sister feature, Shadow 
Copy, offers the same safety net to individual documents. 

• Address-space randomization moves system files around in memory randomly. 
The idea here is to make it extremely difficult to write a virus that will work the 
same way on every PC. 

A Cosmetic Overhaul 
As you've probably discovered already, Windows Vista looks much more modern 
and colorful (and, frankly, Mac-like) than its cosmetically challenged predecessors. 
Thanks to a new design scheme called Aero, Window edges are translucent; menus 
and windows fade away when closed; the taskbar shows actual thumbnail images of 
the open documents, not just their names; all the icons have been redesigned with a 
clean, 3-D look and greater resolution; and so on. 

Note: Not everyone gets to enjoy these features, by the way. Some PCs are too slow to handle all this 
graphics processing; on those machines, Vista will look shiny and new, but won't have these transparency 
and taskbar features. 

Part of what makes Vista look so much better and more modern stems from a very 
small tweak: a new system font, called Sergoe UL New designs for dialog boxes and 
wizards also give the whole affair a fresher, easier to use personality. 

The Start menu is a better-organized, two-column affair; that awful XP business of 
superimposing the All Programs menu on top of the two other columns is long gone. 

By the way, if you don't care for the Vista cosmetic changes, you can turn them off 
selectively, which makes your desktop look and work just as it did in previous versions 
of Windows. (You'll find instructions throughout this book in special boxes labeled 
"Nostalgia Corner.") You can also turn off the various animations, drop shadows, and 
other special effects for a measurable speed boost on slower PCs (see page 612). 
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Merged OSes 
There are no longer separate Windows Media Center and Tablet PC Editions; these 
features are now built right into certain versions of Vista. 

New Programs and Features 
Lots of new or upgraded software programs come with Vista ( or at least some editions 
of it). For example; 

• Photo Gallery. A tidy little digital shoebox, suitable for touching up, organizing, 
and sharing your digital photos. 

• Instant Search. With one keystroke (the:: key), you open the Start menu's new 
Search box. It searches your entire PC for the search phrase you type-even inside 
files that have different names. It's the ultimate efficiency booster-and, by the 
way, a fantastic way to open programs without ever taking your hands off the 
keyboard. 

· Windows Calendar. A very simple calendar for planning your life. 

• Windows Mail. OK, it's really just Outlook Express with a new name, but it does 
have a spam filter now. 

• Windows DVD Maker. Burns video DVDs, complete with a scene menu and 
background music. 

• Windows Meeting Space. A Vista-only replacement for NetMeeting. It lets you 
and your colleagues see each other's screens and pass around notes or documents 
across the network or the Internet. 

· Snipping Tool lets you capture rectangular or irregular patches of the screen as 
graphics, for use in illustrating computer books. 

• Windows Fax and Scan offers one-stop shopping for scanning, and for sending 
and receiving faxes. 

• Internet Explorer 7 has been beefed up. It now has tabbed browsing, RSS news 
feeds, and about 65,000 new security features. 

• Windows Media Player 11 has yet another new look. It can share your music and 
photos across the network with another Vista PC ( or an XBox 360), too. 

• Speech Recognition isn't as accurate as, say, Dragon NaturallySpeaking. But it's 
light-years better than Windows' old speech-recognition feature. If you have a 
headset, you should try it out; you can dictate email and documents, and even 
control Windows itself, all by voice. 

· Laptop goodies including folder synchronization with another computer, more 
powerful battery-control settings, and a central Mobility Center that governs all 
laptop features in one place. The ingenious Presentation Mode prevents dialog 
boxes, screen savers, alerts, or sounds from going off when you're in the middle 
of a presentation. 
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· Super Fetch speeds up your PC by analyzing when you tend to use certain programs, 
so they'll be ready and waiting when you are. ReadyBoost lets you use the RAM 
on a flash drive as extra memory for greater speed. (Cool!) 

• The Sidebar. This feature offers a floating panel filled with tiny, single-purpose 
programs called gadgets: a stock ticker, weather reporter, address book lookup, 
and so on. 

Note: The Sidebar's resemblance to the Dashboard in Mac OS Xis unmistakable. Then again, any number 
of Vista features can be said to have predecessors on the Mac: Windows Calendar, Photo Gallery, 3-D Chess, 
instant Search, Personal and Users folders, flippy triangles in folder lists, the Folder List itself, window drop 
shadows, Flip 3D, rounded window corners, and so on. 

Windows fans, though, may well argue, "So what?" You can't copyright an idea-and there's little doubt that 
these enhancements make Windows better. 

New Explorer Window Features 
At the desktop, the Explorer windows, where you view the icons of your files and 
programs, are bristling with new features. 

· New panes. Explorer windows can now have information panels and controls 
on all four edges, including the new Navigation pane (left); task toolbar (top); 
Preview pane (right); and Details pane (bottom). You can edit those details (that 
is, properties) right in the window, even adding tags (keywords) for fast, easy 
rounding-up later. 

• Stacking, filtering, and grouping. Every Explorer window offers three new methods 
of slicing, dicing, finding, and categorizing the files inside. 

· Document preview. Now you can see what's in a document without having to 
open it first. Its icon actually is the first page of what's inside. That's an especially 
handy feature when it comes to photos. You can also play movies and music files 
right at the desktop, without having to fire up a program first. 

• Address bar. The new Address bar, which displays the path you've taken to burrow 
into the folder you're now inspecting, is loaded with doodads and clickable spots 
that make navigation far easier. 

Version Hell 
You thought Windows XP was bad, with its two different versions (Home and 
Pro)? 

Windows Vista comes in five different versions: Home Basic, Home Premium, Busi­
ness, Enterprise, and Ultimate. And that's not even counting the Starter edition, sold 
exclusively in poor countries outside North America, or the two "N" versions (like 
Home Basic N), which are sold in Europe to comply with a different set of antitrust 
laws. 
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Microsoft says that each version is perfectly attuned to a different kind of customer, 
as though each edition had been somehow conceived differently. In fact, though, the 
main thing that distinguishes the editions is the suite of programs that comes with 
each one. 

E 
::, ... ·e ·;,; 
~ CII ra "' "' CII m ~ "' ·;: -CII CII CII Cl. ra 

C .. E E E ·;,; CII Feature - ::E 0 0 ::, C ::c ::c m Y-1 ::, 

Aero (snazzy new cosmetic design) . . . . 
Attach a second monitor . . . . 
Automated backups . . . . 
Back up to another PC on the network . . . . 
Bitlocker drive encryption . . 
Complete PC backups (disk images) . . . 
Domain-network joining . . . 
DVD Maker . . 
Encrypting File System . . . 
Fax and Scan program . . . 
Group Policy support (system administrators can set . . . 
company-wide settings) 

Media Center . . 
Mobility Center . . . . 
Movie Maker . . . 
Network Access Protection (PCs without virus protection can't . . . 
join the network) 

Network projectors . . . . 
Offline files and folders (auto-sync with network files and . . . 
folders after being away) 

Parental Controls . . . 
Remote Desktop Partial Partial . . . 
Shadow Copy (creates automatic daily backups of files, so you . . . 
can "rewind" to an earlier version) 

Tablet PC features . . . . 
Windows Anytime Upgrade (online upgrade to a higher- . . . 
priced Vista version) 

Windows Meeting Space (collaboration over networks) Can . . . . 
view 
meet-
ings 
only 
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Tip: Vista Enterprise is not sold in any store. It's sold directly to corporations for mass installation by highly 
paid network geeks. It's otherwise identical to the Business edition, except that it adds three specialized 
features: a subsystem for UNIX-based programs, Windows Bitlocker Drive Encryption (page 637), and the 
inclusion of 35 language packs (page 304). 

A huge table, showing what's in each version, appears on the facing page. But to save 
you from having to keep flipping back to this page, each main heading in this book 
bears a handy cheat sheet, like this: 

Home Premium • Business • Enterprise • Ultimate 

This lets you know at a glance whether or not that feature discussion applies to 
you. 

UP TO SPEED 

32-bit vs. 64-bit Vista 
You could say that Windows Vista comes in five editions. You 
could say that it comes in eight (if you count the overseas 
versions). 

You could also multiply all that, because most Vista versions 
are also available in either 32-bit or 64-bit editions. (Vista 
Ultimate comes with both versions in the box; the Business 
or Home versions come with the 32-bit version, with a 
toll-free number that lets you order the 64-bit version at 
no charge.) 

Which leaves only one question: What does it all mean? 
Aren't more bits always better? 

Not necessarily. 

In theory, there are two advantages to a 64-bit computer 
running a 64-bit operating system. First, you can install a 
lot more memory. The most memory you can install on a 
32-bit computer is 4 gigabytes of RAM; on a 64-bit computer, 
the maximum shoots up to 128 gigabytes. (That's for the 
Business, Enterprise, and Ultimate editions of Vista; it's 8 GB 
for Home Basic, and 16 GB for Home Premium.) 

Second, certain people in certain rarefied professions-say, 
Photoshop, digital video, and rocket-science hounds-rely on 
specialized 64-bit programs to get their work done faster. 
And 64-bit programs require 64-bit computers and operating 
systems to match. 

OK, suppose that you do, in fact, have a computer with a 
64-bit processor, like an Intel Core 2 Duo or AMO Athlon 
64 FX. Even then, you might not want to run the 64-bit 
version of Vista. 

First of all, the 32-bit version runs just great on 64-bit 
computers; there's no performance penalty. 

Second, 64-bit is uncharted territory for most people. 64-bit 
processors and operating systems have long been used for 
database servers and other machines that must move large 
amounts of data quickly. But 64-bit Windows hasn't had 
much experience running day-to-day productivity programs 
or video games. If you decide to use 64-bitVista as your desk­
top operating system, you're becoming a volunteer tester to 
give the whole 64-bit Windows notion a shake-down. 

Plenty of people say they've gone 64-bit for months with no 
problems, but an equal number say they have trouble finding 
stable device drivers for 64-bit Windows. That kind of split 
is usually a sign that your mileage may vary. 

So if you're curious and brave, give the 64-bit version a 
try. But be prepared to spend some time in the Microsoft 
Communities Web sites finding answers to issues that come 
up-and paving the way for the rest of the world to run 64-bit 
Vista without incident. 
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Meanwhile, if a description of this or that feature makes you salivate, fear not. 
Microsoft is only too happy to let you upgrade your copy of Windows Vista to a more 
expensive edition, essentially "unlocking" features for a fee. See page 273 for details. 

About This Book 
Despite the many improvements in Windows over the years, one feature hasn't 
improved a bit: Microsoft's documentation. In fact, Windows Vista comes with no 
printed user guide at all. To learn about the thousands of pieces of software that ma~e 
up this operating system, you're expected to read the online help screens. 

Unfortunately, as you'll quickly discover, these help screens are tersely written, 
offer very little technical depth, and lack examples. You can't even mark your place, 
underline, or read them in the bathroom. Some of the help screens are actually on 
Microsoft's Web site; you can't see them without an Internet connection. Too bad if 
you're on a plane somewhere with your laptop. 

The purpose of this book, then, is to serve as the manual that should have accompanied 
Windows Vista. In these pages, you'll find step-by-step instructions for using almost 
every Windows feature, including those you may not even have understood, let alone 
mastered. 

System Requirements for Your Brain 
Windows Vista: The Missing Manual is designed to accommodate readers at every 
technical level ( except system administrators, who will be happier with a very 
different sort of book). 

The primary discussions are written for advanced-beginner or intermediate PC users. 
But if you're a first-time Windows user, special sidebar articles called "Up To Speed" 
provide the introductory information you need to understand the topic at hand. If 
you're an advanced PC user, on the other hand, keep your eye out for similar shaded 
boxes called "Power Users' Clinic." They offer more technical tips, tricks, and shortcuts 
for the veteran PC fan. 

About the Outline 
This book is divided into seven parts, each containing several chapters: 

• Part 1, The Vista Desktop, covers everything you see on the screen when you turn 
on a Windows Vista computer: icons, windows, menus, scroll bars, the Recycle 
Bin, shortcuts, the Start menu, shortcut menus, and so on. It also covers the juicy 
new system-wide, instantaneous Search feature. 

• Part 2, Vista Software, is dedicated to the proposition that an operating system is 
little more than a launch pad for programs. Chapter 6 describes how to work with 
applications and documents in Windows-launch them, switch among them, 
swap data between them, use them to create and open files, and so on-and how 
to use the new micro-programs called gadgets. 
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This part also offers an item-by-item discussion of the individual software nuggets 
that make up this operating system. These include not just the items in your Control 
Panel, but also the long list of free programs that Microsoft threw in: Windows 
Media Player, Movie Maker, WordPad, Speech Recognition, and so on. 

• Part 3, Vista Online, covers all the special Internet-related features of Windows, 
including setting up your Internet account, Windows Mail (for email), Internet 
Explorer 7 (for Web browsing), and so on. The massive Chapter 10 also covers 
Vista's dozens oflnternet fortification features: the firewall, anti-spyware software, 
parental controls, and on and on. 

• Part 4, Pictures, Movies, and Music, takes you into multimedia land. Here are 
chapters that cover the new Photo Gallery picture editing and organizing program; 
Media Player 11 (music playback); Media Center (TV recording and playback); 
Movie Maker (video editing); and DVD Maker (burn your own video DVDs). 

• Part 5, Hardware and Peripherals, describes the operating system's relationship 
with equipment you can attach to your PC-scanners, cameras, disks, printers, and 
so on. Special chapters describe faxing, fonts, laptops, and Tablet PC touch-screen 
machines. 

• Part 6, PC Health, explores Vista's greatly beefed-up backup and troubleshooting 
tools. It also describes some advanced hard drive formatting tricks and offers tips 
for making your PC run faster and better. 

• Part 7, The Vista Network, is for the millions of households and offices that contain 
more than one PC. If you work at home or in a small office, these chapters show you 
how to build your own network; if you work in a corporation where some highly 
paid professional network geek is on hand to do the troubleshooting, these chapters 
show you how to exploit Vista's considerable networking prowess. File sharing, ac­
counts and passwords, and the new remote-control collaboration program called 
Windows Meeting Space are here, too. 

At the end of the book, three appendixes provide a guide to installing this operating 
system, an introduction to editing the Registry, and the "Where'd It Go?" Dictionary, 
which lists every feature Microsoft moved or deleted on the way to Windows Vista. 

About➔ These➔Arrows 
Throughout this book, and throughout the Missing Manual series, you'll find sentences 
like this: "Open the Start➔Computer➔Local Disk (C:)➔Windows folder." That's 
shorthand for a much longer instruction that directs you to open three nested icons 
in sequence, like this: "Click the Start menu to open it. Click Computer in the Start 
menu. Inside the Computer window is a disk icon labeled Local Disk (C:); double­
click it to open it. Inside that window is yet another icon called Windows. Double-click 
to open it, too." 

Similarly, this kind of arrow shorthand helps to simplify the business of choosing 
commands in menus, as shown in Figure 1-1. 
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You're invited and encouraged to submit corrections and updates to this book's Web 
page at www.missingmanuals.com. (Click the book's name, and then click the Errata 
link.) In an effort to keep the book as up-to-date and accurate as possible, each time 
we print more copies of this book, we'll make any corrections you've suggested. 

Even if you have nothing to report, you should check that Errata page now and then. 
That's where we'll post a list of the corrections and updates we've made, so that you 
can mark important corrections into your own copy of the book, if you like. 

In the meantime, we'd love to hear your suggestions for new books in the Missing 
Manual line. There's a place for that on the Web site, too, as well as a place to sign up 
for free email notification of new titles in the series. 

Figure I-I: 
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The Very Basics 
To get the most out of Windows with the least frustration, it helps to be familiar with 
the following concepts and terms. If you're new to Windows, be prepared to encounter 
these words and phrases over and over again-in the built-in Windows help, in com­
puter magazines, and in this book. 

Windows Defined 
Windows is an operating system, the software that controls your computer. It's designed 
to serve you in several ways: 

• It's a launching bay. At its heart, Windows is a home base, a remote-control clicker 
that lets you call up the various software programs (applications) you use to do 
work or kill time. When you get right down to it, applications are the real reason 
you bought a PC. 

Windows Vista is a well-stocked software pantry unto itself; for example, it comes 
with such basic programs as a Web browser, email program, simple word processor, 
and calculator. Vista comes with a suite of games, too. ( Chapter 7 covers all of 
these freebie programs.) 

If you were stranded on a desert island, the built-in Windows programs could 
suffice for everyday operations. But if you're like most people, sooner or later, 
you'll buy and install more software. That's one of the luxuries of using Windows: 
you can choose from a staggering number of add-on programs. Whether you're a 
left-handed beekeeper or a German-speaking nun, some company somewhere is 
selling Windows software designed just for you, its target audience. 

• It's a file cabinet. Every application on your machine, as well as every document 
you create, is represented on the screen by an icon, a little picture that symbolizes 
the underlying file or container. You can organize these icons into onscreen file 
folders. You can make backups (safety copies) by dragging file icons onto a floppy 
disk or blank CD, or send files to people by email. You can also trash icons you 
longer need by dragging them onto the Recycle Bin icon. 

• It's your equipment headquarters. What you can actually see of Windows is only 
the tip of the iceberg. An enormous chunk of Windows is behind-the-scenes 
plumbing that controls the various functions of your computer-its modem, 
screen, keyboard, printer, and so on. 

The Right Mouse Button is King 
One of the most important features of Windows isn't on the screen-it's under your 
hand. The standard mouse has two mouse buttons. You use the left one to click 
buttons, highlight text, and drag things around on the screen. 

When you click the right button, however, a shortcut menu appears onscreen, like the 
one shown at left in Figure 1-3. Get into the habit of right-clicking things-icons, fold­
ers, disks, text inside a paragraph, buttons on your menu bar, pictures on a Web page, 
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The Very Basics and so on. The commands that appear on the shortcut menu will make you much 
more productive and lead you to discover handy functions you never knew existed. 
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This is a big deal: Microsoft's research suggests that nearly 75 percent of Windows 
users don't use the right mouse button, and therefore miss hundreds of timesaving 
shortcuts. Part of the rationale behind Windows Vista's redesign is putting these 
functions out in the open. Even so, many more shortcuts remain hidden under your 
right mouse button. 

Tip: Microsoft doesn't discriminate against left-handers ... much. You can swap the functions of the right 
and left mouse buttons easily enough. 

Choose Start➔Control Panel. Click "Classic view." Open the Mouse icon. When the Mouse Properties 
dialog box opens, click the Buttons tab, and then turn on "Switch primary and secondary buttons." Then 
click OK. Windows now assumes that you want to use the left mouse button as the one that produces 
shortcut menus. 

Set up a wireless ad hoc (computer-to-computer) network 

The Lesa network is ready to use 

@ ~ Set up a wtreless ad hoc (computer-to-computer) network 

Set up a wireless ad hoc network 

p<)III)' 

'°' ultiplc 
~ ~-.; Set up 11 connection or Mtwork 

Choose a connection option 
hen you 

~;'}},1 Connect to the Internet 
·W Set up J ~,;ifele::;s, broa dband~ o r dia!-up conn ection to the lntcrn e-t. 

11.fftl Set up a wireless router or access point 
f~ Set up a ne,•1 \-\i re:les:, n etv1crk for ycur h ome or ~ma ll b~1si nc:~s. 

~c Manually ~onnect to a wireless network 
~ Choose th1~ to conr1 1::ct to~ hidden network or create a new w irelo2.;;s pre.fil e, 

Set u11.: W\t~ .oJ hoc ((cmpu.tH·l~compuret) netv.o,I 
uo • tcmf)OMI\' nt1¥,ork rot ~hnrinn Iii~ or an lntt:mc~ ccinncC'bOn 

,6-'"1... Set up a dial-up connection 
~ Cot111e:ct through a dial -up connection to th~Jnterne.t. 

WINDOWS VISTA: THE MISSING MANUAL 

on• 

ring. 

Figure /-2: 
Wizards (interview 
screens) are every­
where in Windows. On 
each of the screens, 
you're supposed to 
answer a question 
about your computer 
or your preferences, 
and then click a Next 
button. When you 
click the Finish button 
on the final screen, 
Windows whirls into 
action, automatically 
completing the instal­
lation or setup. 



~ 

Wizards = Interviews 
A wizard is a series of screens that walks you through the task you're trying to complete. 
Wizards make configuration and installation tasks easier by breaking them down into 
smaller, more easily digested steps. Figure I-2 offers an example. 

There's More Than One Way to Do Everything 
No matter what setting you want to adjust, no matter what program you want to 
open, Microsoft has provided five or six different ways to do it. For example, here are 
the various ways to delete a file: press the Delete key; choose File➔Delete; drag the 
file icon onto the Recycle Bin; or right-dick the file name, and then choose Delete 
from the shortcut menu. 

Pessimists grumble that there are too many paths to every destination, making it 
much more difficult to learn Windows. Optimists point out that this abundance of 
approaches means that almost everyone will find, and settle on, a satisfying method for 
each task. Whenever you find a task irksome, remember you have other options. 

You Can Use the Keyboard for Everything 
In earlier versions of Windows, underlined letters appeared in the names of menus 
and dialog boxes. These underlines were clues for people who found it faster to do 
something by pressing keys than by using the mouse. 

The underlines are hidden in Windows Vista, at least in disk and folder windows. (They 
may still appear in your individual software programs.) If you miss them, you can make 

UP TO SPEED 

Scrolling: The Missing Manual 

These days, PC monitors are bigger than ever-but so are the 
Web pages and documents that they display. 

Scroll bars, of course, are the strips that may appear at 
the right side and/or bottom of a window. The scroll bar 
signals you that the window isn't big enough to reveal all 
of its contents. 

Click the arrows at each end of a scroll bar to move slowly 
through the window, or drag the rectangular handle (the 
thumb) to move faster. (The position of the thumb in the 
scroll bar reflects your relative position in the entire window 
or document.) You can quickly move to a specific part of the 
window by holding the mouse button down on the scroll 
bar where you want the thumb to be. The scroll bar rapidly 
scrolls to the desired location and then stops. 

Scrolling is such a frequently needed skill, though, that all 

kinds of other scrolling gadgets have cropped up. 

Your mouse probably has a little wheel on the top. You 
can scroll in most programs just by turning the wheel with 
your finger, even if your cursor is nowhere near the scroll 
bar. You can turbo-scroll by dragging the mouse upward or 
downward while keeping the wheel pressed down inside 
the window. 

Laptops often have some kind of scrolling gizmo, too. 
Maybe you have an actual roller, or maybe the trackpad 
offers drag-here-to-scroll strips on the right side and across 
the bottom. 

Of course, keyboard addicts should note that you can scroll 
without using the mouse at all. Press the Page Up or Page 
Down keys to scroll the window by one window-full, or use 
the up and down arrow keys to scroll one line at a time. 
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them reappear by pressing the Alt key, Tab key, or an arrow key whenever the menu 
bar is visible. (When you're operating menus, you can release the Alt key immediately 
after pressing it.) In this book, in help screens, and computer magazines, you'll see key 
combinations indicated like this: Alt+S ( or Alt+ whatever the letter key is). 

Note: In some Vista programs, in fact, the entire menu bar is gone until you press Alt (or FlO). That includes 
everyday Explorer windows. 

Once the underlines are visible, you can open a menu by pressing the underlined letter 
(F for the File menu, for example). Once the menu is open, press the underlined letter 
key that corresponds to the menu command you want. Or press Esc to close the menu 
without doing anything. (In Windows, the Esc key always means cancel or stop.) 

If choosing a menu command opens a dialog box, you can trigger its options by 
pressing Alt along with the underlined letters. (Within dialog boxes, you can't press 
and release Alt; you have to hold it down while typing the underlined letter.) 

About Shift-Clicking 
Here's another bit of shorthand you'll find in this book (and others): instructions to 
Shift-click something. That means you should hold down the Shift key, and then click 
before releasing the key. If you understand that much, the meaning of instructions 
like "Ctrl-click" and "Alt-click" should be clear. 

You Could Spend a Lifetime Changing Properties 
You can't write an operating system that's all things to all people, but Microsoft has 
certainly tried. You can change almost every aspect of the way Windows looks and 
works. You can replace the gray backdrop of the screen (the wallpaper) with your 
favorite photograph, change the typeface used for the names of your icons, or set up 
a particular program to launch automatically every time you turn on the PC. 

When you want to change some general behavior of your PC, like how it connects to 
the Internet, how soon the screen goes black to save power, or how quickly a letter 
repeats when you hold down a key, you use the Control Panel window ( described 
in Chapter 8). 

Many other times, however, you may want to adjust the settings of only one particu­
lar element of the machine, such as the hard drive, the Recycle Bin, or a particular 
application. In those cases, simply right-dick the corresponding icon. In the resulting 
shortcut menu, you'll often find a command called Properties. When you click it, a 
dialog box appears, containing settings or information about that object, as shown 
in Figure I-3. 

Tip: As a shortcut to the Properties command, just highlight an icon and then press Alt+Enter. 

It's also worth getting to know how to operate tabbed dialog boxes, like the one shown 
in Figure I-3. These are windows that contain so many options, Microsoft has had to 
split them up into separate panels, or tabs. To reveal a new set of options, just click a 
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different tab ( called General, Tools, Hardware, Sharing, Security, and Quota in Figure 
I-3 ). These tabs are designed to resemble the tabs at the top of file folders. 

Tip: You can switch tabs without using the mouse by pressing Ctrl+ Tab (to "click" the next tab to the right) 
or Ctrl+Shift+Tab (for the previous tab). 

Figurel-J: 
One quick way 
to find out how 
much space 
is left on your 
hard drive is to 
right-dick the 
correspond-
ing icon, and 
then choose 
the Properties 
command (left). 
The Properties 
dialog box 
appears (right), 
featuring a 
handydisk­
space graph. 
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Every Piece of Hardware Requires Software 
When computer geeks talk about their drivers, they're not talking about their 
chauffeurs (unless they're Bill Gates); they're talking about the controlling software 
required by every hardware component of a PC. 

The driver is the translator between your PC's brain and the equipment attached to 
it: mouse, keyboard, screen, DVD drive, scanner, digital camera, palmtop, and so on. 
Without the correct driver software, the corresponding piece of equipment doesn't 
work at all. 

When you buy one of these gadgets, you receive a CD containing the driver software. 
If the included driver software works fine, then you're all set. If your gadget acts up, 
however, remember that equipment manufacturers regularly release improved (read: 
less buggy) versions of these software chunks. (You generally find such updates on 
the manufacturers' Web sites.) 

Fortunately, Windows Vista comes with drivers for over 12,000 components, saving 
you the trouble of scavenging for them on a disk or on the Internet. This gigantic 
library is the heart of Microsoft's Plug and Play feature, which lets you connect a new 
gadget to your PC without even thinking about the driver software (Chapter 18). 

INTRODUCTION 15 



The Very Basics 

16 

Ifs Not Meant to Be Overwhelming 
Windows has an absolutely staggering array of features. You can burrow six levels 
down, dialog box through dialog box, and never come to the end of it. There are enough 
programs, commands, and help screens to keep you studying the rest of your life. 

It's crucial to remember that Microsoft's programmers created Windows in 
modules-the digital-photography team here, the networking team there-with 
different audiences in mind. The idea, of course, was to make sure that no subset of 
potential customers would find a feature lacking. 

But if you don't have a digital camera, a network, or whatever, there's absolutely 
nothing wrong with ignoring everything you encounter on the screen that isn't 
relevant to your setup and work routine. Not even Microsoft's CEO uses every 
single feature of Windows Vista. 
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Once you've recovered from the excitement of the Welcome Center, you get your first 
glimpse of the full Vista desktop. 

All of the usual Windows landmarks are here-the Start menu, taskbar, and Recycle 
Bin-but they've been given a drastic cosmetic overhaul. 

If you're into this kind of thing, here's the complete list of what makes Aero Aero: 

• The edges of windows are thicker (for easier targeting with your mouse). Parts of 
the Start menu and window edges are transparent. Windows and dialog boxes cast 
subtle shadows on the background, as though they're floating. 

• A new, bigger, more modern font is used for menus and labels. 

• When you point to a window button without clicking, the button "lights up:' The 
Minimize and Maximize buttons glow blue; the Close button glows red. 

• The default button in a dialog box-the one Microsoft thinks you really want, like 
Save or Print-pulses gently, using fading color intensity to draw your eye. 

NOSTALGIA CORNER 

Restoring the Desktop Icons 
The Vista desktop, like the XP desktop before it, is a victim of desktop. To do so, right-click a blank spot on the desktop; 
Microsoft's clean-freak tenden- from the shortcut menu, choose 

Personalize. cies. It's awfully pretty-but aw- lit Desktop kon_Sttting, 

fully barren. Windows veterans ,------ - - ~~---- -, ! 
Now the Personalization dialog 
box appears. In the Tasks pane 
on the left side, click "Change 
desktop icons." 

may miss the handy desktop 
icons that once provided quick 
access to important locations 
on your PC, like My Computer, 
My Documents, My Network 
Places, and Internet Explorer. 

You can still get to these loca­
tions-they're listed in your 
Start menu-but opening them 
requires two mouse clicks (in­
cluding one to open the Start 
menu)- an egregious expendi­
ture of caloric effort. 

However, if you miss the older 

Co""'1er 

t~ 
Recycle Bi.n 

(empty) 

Ca,ey 

arrangement, it's easy enough to put these icons back on the 

~-•Elin 
11!,.Con!rol Panel 

Netwo,k 

As shown here, checkboxes 
for the common desktop icons 
await your summons: Com­
puter, Network, Internet Ex­
plorer, Control Panel, and User's 
Files (that is, your Personal 
folder-see page 38). 

Turn on the ones you'd like to 
install onto the desktop and 
then click OK. Your old favorite 

icons are now back where they once belonged. 

WINDOWS VISTA: THE MISSING MANUAL 



• Little animations liven up the works, especially when you minimize, maximize, or 

close a window. 

Aero isn't just looks, either-it also includes a couple of features, like Flip 3D and live 
taskbar icons. You can read about these two useful features in Chapter 2. 

Tip: Windows Vista also includes all-new sounds, too-the little blips and bleeps you hear when you wake 
up or shut down the PC, get an error message, and so on. 

Microsoft wishes you to know, in particular, that the new Windows startup sound "has two parallel melodies, 
played in an intentional 'Win-dows Vis-ta' rhythm; consists of four chords, one for each color in the Windows 
flag; is 4 seconds long, end to end; and is a collaboration between contributors Robert Fripp (primary melody), 
Tucker Martine (rhythm), and Steve Ball (harmony and final orchestration)." Any questions? 

Figure 1-2: 
There's a new 
desktop picture in 
Vista-Microsoft 
evidently endured 
one Teletubbies 
joke too many dur­
ing the Windows 
XPera-anda 
glowing, more 
modern look 
called Aero. The 
only truly new 
element is the 
Sidebar, the stack 
at small floating 
windows that ap­
pears at the right 
side of the screen. 
(Chapter 6 covers 
the Sidebar in 
detail.) 
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19) Windows DVD Maker 

~ \'{111dovnMert1ng Sp1cc 
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What you're seeing is the new face of Windows, known to fans as Aero. (It supposedly 
stands for Authentic, Energetic, Reflective, and Open, but you can't help suspecting 
that somebody at Microsoft retrofitted those words to fit the initials.) 

The Aero design may not actually be Authentic or whatever, but it does look clean and 
modern. You'll see it, however, only if you have a fairly fast, modern PC. Basically, you 
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• Left side (white). At the top, above the thin divider line, is the pinned items list, 
which is yours to modify; it lists programs, folders, documents, and anything else 
you want to open quickly. This list never changes unless you change it. 

Below that is the standard Windows most frequently used programs list. This list is 
computed automatically by Windows and may change from day to day. 

Tip: You can, if you wish, ask Vista not to display a list of the programs you've used most recently. You 
might want to do that if, for example, it would be best if your boss or your spouse didn't know what you've 
been up to. 

If that's your situation ( or your boss), right-click the Start button itself; from the shortcut menu, choose Proper­
ties. In the resulting dialog box, turn off "Store and display a list of recently opened programs." Click OK. 

When you next inspect the Start menu, you'll be surprised-but happy-to see that the lower-left quadrant, 
where the recently used programs are usually listed, is startlingly blank. 

Figure 1-J: 
Left: The Start menu's 
top-left section is yours 
to play with. You can 
"pin" whatever pro­
grams you want here, 
in whatever order you 
like. The lower-left sec­
tion lists programs you 
use most often. (You 
can delete individual 
items here-see page 
52-but you can't add 
things manually or 
rearrange them.) The 
right-hand column 
links to important 
Windows features and 
folder locations. 

Right: The All Pro­
grams menu replaces 
the left column of the 
Start menu, listing 
almost every piece of 
software you've got. 
You can rearrange, 
add to, or delete items 
from this list. 
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• Right side (dark). In general, the right side of the open Start menu is devoted to 
listing important places on the computer: folders like Documents, Pictures, and 
Music, or special windows like Network, Control Panel, and Computer. 
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Tip: Submenus, also known as cascading menus, have been largely eliminated from the Start menu. In­
stead, when you open something that contains other things-like a folder listed in the Start menu-you see 
its contents listed beneath, indented slightly, as shown in Figure 1-5. Click the folder name again to collapse 
the sublisting. 

Keyboard freaks should note that you can also open a highlighted folder in the list by pressing the Enter key 
(or the right arrow key). Close the folder by pressing Enter again (or the left arrow key). 

Program-group folders 
Another set of folders is designed to trim down the Programs menu by consolidating 
related programs, like Games,Accessories (little single-purpose programs), and Extras 
and Upgrades. Everything in these folders is described in Chapter 7. 

The Startup folder 
This folder contains programs that load automatically every time you start Windows 
Vista. This can be a very useful feature. For instance, if you check your email every 
morning, you may as well save yourself a few mouse clicks by putting your email 
program into the Startup folder. If you spend all day long word processing, you may 
as well put Microsoft Word in there. 

In fact, although few PC users suspect it, what you put into the Startup folder doesn't 
have to be an application. It can just as well be a document you consult every day. It 
can even be a folder or disk icon whose window you'd like to find open and waiting 
each time you turn on the PC. (The Documents folder is a natural example.) 

Of course, you may be interested in the Startup folder for a different reason: to stop 
some program from launching itself. This is a particularly common syndrome if 
somebody else set up your PC. Some program seems to launch itself, unbidden, every 
time you turn the machine on. 

Tip: All kinds of programs dump components into this folder. Over time, they can begin to slow down your 
computer. If you're having trouble determining the purpose of one startup program or another, visit this 
Web page, which provides a comprehensive list of every startup software nugget known, with instructions 
for turning off each one: http//wvvw.sysinfo.org/startupinfo.html. 

Fortunately, it's easy to either add or remove items from the Startup folder: 

• Deleting something. With the Startup folder's listing visible in the All Programs 
menu, right-dick whatever you want to delete. From the shortcut menu, choose 
Delete. Click Yes to send the icon to the Recycle Bin. 

Enjoy your newfound freedom from self-launching software. 

• Adding something. With the All Programs list open, right-dick the Startup folder 
and, from the shortcut menu, choose Open. You've just opened the Startup folder 
itself. 
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A few people knew about Standby mode and used that instead. This special state of 
PC consciousness reduced the amount of electricity the computer used, putting it in 
suspended animation until you used the mouse or keyboard to begin working again. 
Whatever programs or documents you were working on remained in memory. 

When using a laptop on battery power, Standby was a real boon. When the flight 
attendant banded over your microwaved chicken teriyaki, you could take a break 
without closing all your programs or shutting down the computer. 

Unfortunately, there were two big problems with Standby, especially for laptops: 

• The PC still d.re,v a trickle of power this way. If you didn't use your laptop for a 
few days, the battery would silently go dead- and everything you had open and 
unsaved would be lost forever. 

• Drivers or programs sometimes interfered with Standby, so your laptop remained 
on even though it was closed inside your carrying case. Your plane would land on 
the opposite coast, you'd pull out the laptop for the big meeting, and you'd discover 
that (a) the thing was roasting hot, and (b) the battery was dead. 

In Windows Vista, Microsoft has fixed Standby. Now it's called Sleep, and now it 
doesn't present those problems. 

First, drivers and applications are no longer allowed to interrupt the Sleep process. 
No more Hot Laptop Syndrome. 

Second, the instant you put the computer to sleep, Vista quietly transfers a copy of 
everything in memory into an invisible file on the hard drive. But at the same time, it 
still keeps everything alive in memory-the battery provides a tiny trickle of power-in 
case you return to the laptop ( or desktop) and want to dive back into work. 

If you do return soon (within 18 hours, although this period varies by laptop model) , 
the next startup is lightning-fast. Everything reappears on the screen faster than you 
can say, "Redmond, Washington." After you've enjoyed the speed of a power-up from 
Sleep mode, the normal startup seems unbearably slow. 

But now suppose you don't return after 18 hours ( or the battery dies while providing 
the trickle of ju.ice). In that case, Vista cuts power, abandoning what it had memorized 
in RAM. Now your computer is using no power at all. The laptop battery isn't slowly 
running down; the desktop isn't contributing to global warming. 

Fortunately, Windows still has the hard drive copy of your work environment. So now 
when you tap a key to wake the computer, you might have to wait 30 seconds or so-not 
as fast as two seconds, but certainly better than the five minutes it would take to start 
up, reopen all your programs, reposition your document windows, and so on. 

So here's the bottom line: when you're done working for the moment-or for the 
day-put your computer to Sleep instead of shutting it down. You save power, you 
save time, and you risk no data loss. 

You can send a laptop to Sleep just by closing the lid. On any kind of computer, you 
can trigger Sleep by choosing Start~(!}. 
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Start--4Log Off, 
Restart, Etc. 
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· Restart. This command quits all open programs, then quits and restarts Windows 
again automatically. The computer doesn't actually turn off. (You might do this 
to "refresh" your computer when you notice that it's responding sluggishly, for 
example.) 

• Sleep. You can read about Sleep on page 30. 

• Hibernate. Hibernate mode is a lot like Sleep, except that it doesn't offer a 15-min­
ute period during which the computer will wake up instantly (because it's keeping 
your open files and programs alive in RAM). Hibernate equals the second phase 
of Sleep mode, in which your working world is saved to the hard drive. Waking 
the computer from Hibernate takes about 30 seconds-not as fast as waking from 
the first 18 hours of Sleep, but much faster than starting from Off and having to 
reopen all your programs. 

Tip: You can configure your computer to sleep or hibernate automatically after a period of inactivity, or to 
require a password to bring it out of hibernation. See page 300 for details. 

• Shut Down. This is what most people would call "really, really off."When you shut 
down your PC, Windows quits all open programs, offers you the opportunity to 
save any unsaved documents, exits Windows, and turns off the computer. 

Tip: Once again, it's worth noting that you can trigger any of these commands entirely from the keyboard; 
save your mouse for Photoshop. 

Hit the:: key to open the Start menu. Then hit the right arrow key three times to open the menu shown 
in Figure 1-6. At this point, you can type the underlined letter of the command you want: L for Log Off, U 
for Shut Down, and so on. 

Start ➔Help and Support 
All Versions 

Choosing Start➔Help and Support opens the new, improved Windows Help and 
Support Center window, which is described in Chapter 5. 

Tip: Once again, speed fans have an alternative to using the mouse-just press the Fl key to open the 
Help window. (If that doesn't work, some other program may have Vista's focus. Try it again after clicking 
the desktop.) 

Start➔Default Programs 
All Versions 

This command is just a shortcut to the Default Programs control panel. 
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If you're a PC veteran, your head probably teems with neat Run commands you've 
picked up over the years. If you're new to this idea, however, the following are a few 
of the useful and timesaving functions you can perform with the Run dialog box. 

Open a Program 
For example, you can use the Run command as a program launcher. Just type any 
program's program file name in the Open text box and then press Enter. That's a use­
ful shortcut for both pros and novices alike, because it's frequently faster to launch a 
program this way than to click the Start➔All Programs menu with the mouse. 

Unfortunately, the program file name isn't the same as its plain-English name; it's a 
cryptic, abbreviated version. For example, if you want to open Microsoft Word, you 
must type winword. That's the actual name of the Word program icon as it sits in 
your Computer➔ Local Disk ( C: )➔ Program Files➔Microsoft Office➔Office folder. 
Some other common program file names are shown here: 

Program's real name 
iexplore 
explorer 
write 
msworks 
msimn 
wmplayer 
palm 
sol 
wmmme 
control 
regedit 
c/eanmgr 
defrag 
cote 

Program's familiar name 
Internet Explorer 
Windows Explorer 
WordPad 
Microsoft Works 
Mail 
Windows Media Player 
Palm Desktop 
Solitaire 
Minesweeper 
Classic Control Panel 
Registry Editor 
Disk Cleanup 
Disk Defragmenter 
Calculator 

UP TO SPEED 

The Path to Enlightenment about Paths 

Windows is too busy to think of a particular tile as "that family 
album program in the Program Files folder, which is in the 
Programs folder on the C drive." Instead, it uses shorthand 
to specify each icon's location on your hard drive-a series 
of disk and folder names separated by backslashes, like this: 

Microsoft's examples.) 

You'll encounter file paths when using several important 
Windows features. The Run dialog box described in this 
section is one. The Address bar at the top of every Explorer 
window is another, although Microsoft has made addresses 
easier to read by displaying triangle separators in the Address 
bar instead of slashes. (That is, you now see Users ► Casey 
instead of Users\Casey.) 

C:\program fi/es\pbsoftware lbeekeeperpro. exe. 

This kind of location code is that icon's path. (Capitalization 
doesn't matter, even though you may see capital letters in 
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· Local Disk (C:)➔Users➔ [your name]➔AppData➔Roaming➔Microsoft➔ 

Windows➔Start Menu➔Programs folder. This invisible folder stashes shortcuts 
for the programs that you have added to the Start menu-and they appear only 
when you have logged into the machine. 

Therefore, instead of the fancy icon-adding wizards and drag-and-drop schemes 
described above, you may prefer to fine-tune your Start menu the low-tech way. Just 
open the relevant Start Menu folder-and you don't have to do any burrowing into 
invisible folders, either. See Figure 1-13. 

Removing Icons from the Start Menu 
When it comes time to prune an overgrown Start menu, there are three different sets 
of instructions, depending on which section of the Start menu needs purging. 

· The left-side column and All Programs list. Right-dick the item you've targeted 
for extinction, and then, from the shortcut menu, choose either "Remove from 
this list" or "Delete." 

In both cases, you're only deleting the shortcut that appears on the menu. Deleting 
items from the Start menu doesn't actually uninstall any software. 

· The right-side column. Open the Properties➔Customize dialog box for the 
Start menu (page 44), and then turn off the checkboxes for the items you want 
expunged. 

Tip: You can spawn instant shortcuts (page 145) of anything in the left-hand column of the Start menu by 
dragging them off the menu-onto the desktop, for example. That's a handy tactic if you want a desktop icon 
for something you use often, so you don't even have to open the Start menu to get at it. 

Renaming Start-Menu Items 
Although few people realize it, you can rename anything in the Start menu's left side. 
Click the Start menu to open it, right-dick the command you want to rename, and 
choose Rename from the shortcut menu. The name of the command sprouts a little 
editing box. Type the new name and then press Enter. 

Reorganizing the Start Menu 
To change the order of listings in the "free" portions of the Start menu, including the 
All Programs list, just drag the commands up and down the lists as you see fit. As you 
drag an item, a black line appears to show you the resulting location of your drag­
ging action. Release the mouse when the black line is where you want the relocated 
icon to appear. 

Tip: If you change your mind while you're dragging, press the Esc key to leave everything as it was. 

You can drag program names from the lower-left section of the Start menu, too-but 
only into one of the "free" areas. 
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Tip: A reminder: If you can't seem to drag program names around in the All Programs list, it's probably 
because you've told Vista to auto-alphabetize this list (page 48). 

Add folders to hold submenus 
As noted earlier, some of the items in the All Programs list are actually folders. For 
example, clicking Games reveals a submenu that lists all the games that come with 
Windows (see Figure 1-14). 

In past Windows versions, clicking such folders made them sprout submenus, some of 
which had sub menus of their own, and on and on. In Vista, folders no longer expand 
horizontally that way-they expand vertically, as shown in Figure 1-14. 

Figure 1-14: 
Some Programs-menu 
items have submenu 
folders and sub-submenu 
folders. As you move 
through the layers, you're 
performing an action 
known as "drilling down." 
You'll see this phrase often 
in manuals and computer 
books-for example, "Drill 
down to the Calculator 
to crunch a few quick 
numbers." 
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It's worthwhile to know that you can create Programs-menu folders of your own 
and stock them with whatever icons you like. For instance, you may want to create a 
folder for CD-ROM-based games, eliminating those long lists from the All Programs 
menu. 
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Explorer, Windows, 
and the Taskbar 

Windows got its name from the rectangles on the screen-the windows­
where every computer activity takes place. You look at a Web page in a 
window, type into a window, read email in a window, and look at lists of 

files in a window. But as you create more files, stash them in more folders, and open 
more programs, it's easy to wind up paralyzed before a screen awash with cluttered, 
overlapping rectangles. 

Fortunately, Windows has always offered icons, buttons, and other inventions to 
help you keep these windows under control-and Windows Vista positively crawls 
with them. 

Universal Window Controls 
All Versions 

There are two categories of windows in Windows: 

• Explorer windows. Windows Explorer is Microsoft's name for the desktop world of 
folders and icons. It's the home-base program that greets you when you first turn on 
the PC. When you double-dick a folder or disk icon on your desktop, what opens 
is an Explorer window. This is where you organize your files and programs. 

• Application windows. These are the windows where you do your work-in Word 
or Internet Explorer, for example. 

All of these windows have certain parts in common, but as Figure 2-1 shows, a lot has 
changed since the last version of Windows you probably used. If you're feeling disori­
ented, firmly grasp a nearby stationary object and read the following breakdown. 
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Universal Window 
Controls 

Here are the controls that appear on almost every window, whether in an application 
or Explorer: 
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Control menu 

ffi} Documents 

~ Picturc!i 

!fJi Music 

(B Recently Changed 

More>> 

Folders 

!fl Desktop 

[l Documents 
It] Downloads 

tf- Favorites 

lll un1cs 
fl' Music 
l_i- Pictur5 · 

• Title bar. It's really not much of a title bar anymore, since the window's title no 
longer appears here (Figure 2-1). But this big fat top strip is still a giant handle 
that you can use to drag a window around. 

Tip: If you double-click the title bar area, you maximize the window, making it expand to fill your entire 
screen exactly as though you had clicked the Maximize button described below. Double-click the title bar 
again to restore the window to its original size. 

Address bar Title bar 

swan 

Great Baby Pix Foliage 

Minimize, Maximize, Close 

sunsetl 

Toolbar 

Scroll 
bar 

Figure 2-1: 
All windows have the 
same basic ingredients, 
making it easy to become 
an expert in window 
manipulation. This figure 
shows an Explorer (desk­
top) window-a disk or 
folder-but you'll encoun­
ter the same elements in 
application windows. 

u--...,_~s.,r,ec1= G•mes •--'---------~-----~--...i· 

ii A~ Clouds Date taken: Specify date and time taken 
JPEG Image T~gs: Add a tag 

· Window edges. Now they're fatter, making them easier to grab with your mouse. 
And on most computers, window edges are also transparent, revealing a slightly 
blurry image of what's underneath. (That's the Aero cosmetic overhaul at work; 
see page 22.) 

Truth to tell, being able to see what's underneath the edges of your window (sort 
of) doesn't really offer any particular productivity advantage. Sure does look cool, 
though. 

In any case, you can change the size of a window by dragging any edge except the 
top. Position your cursor over any border until it turns into a double-headed ar­
row. Then drag inward or outward to reshape the window. (To resize a full-screen 
window, click the Restore Down button first.) 
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Tip: You can resize a window in both dimensions at once just by dragging one of its corners. Sometimes 
diagonally striped ribs appear at the lower-right corner, sometimes not; in either case, all four corners work 
the same way. 

• Minimize, Maximize, [Restore Down]. These three window-control buttons, which 
appear at the top of every Windows window, are much bigger in Vista than before, 
which is supposed to make them easier to click. These buttons cycle a window 
among its three modes-minimized, maximized, and restored-as described on 
page 86. 

• Close button. Click the X button to close the window. Keyboard shortcut: Press 
Alt+F4. 

Tip: Isn't it cool how the Minimize, Maximize, and Close buttons "light up" when your cursor passes over 
them? 

Actually, that's not just a gimmick; it's a cue that lets you know when the button is clickable. You might not 
otherwise realize, for example, that you can close, minimize, or maximize a background window without first 
bringing it forward. But when the background window's Close box beams bright red, you'll know. 

• Scroll bar. A scroll bar appears on the right side or bottom of the window if the 
window isn't large enough to show all its contents ( as described in the box on page 
13). 

• Control menu. Until Windows Vista came along, there was a tiny icon in the 
upper-left corner of every Explorer window (Figure 2-1). It was actually a menu 
containing commands for sizing, moving, and closing the window. 

There are three super-weird nuggets of wisdom to impart about the Control icon 
in Vista. First, it's invisible. There's no icon to let you know it's there. But if you 
click where it's supposed to be, the menu opens. It's clearly intended for use only 
by the initiated who pass on the secret from generation to generation. 

Second, one of the Control menu's commands is Move. It turns your cursor into 
a four-headed arrow; at this point, you can move the window by dragging any 
part of it, even the middle. (And why bother, since you can always just drag the 
top edge of a window to move it? Because sometimes, windows get dragged past 
the top of your screen. You can hit Alt+Space to open the Control menu, type M 
to trigger the Move command, and then drag any visible part of the window back 
onto the screen.) 

Finally, it's worth noting that you can open the identical menu by right-clicking 
anywhere on the title bar. 

Tip: You can double-click the Control menu to close a window. 
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Explorer Window 
Controls 

I.[} Documents 

More» 

Folders 

Deslctop 

l:J Doatm<nts 

II Downloads 

ti Favorit .. 
C, Music 
El Pictu, .. 

Explorer Window Controls 
All Versions 

When you're working at the desktop-that is, opening Explorer windows-you'll find 
a few additional controls dotting the edges. Again, they're quite a bit different from 
the controls of Windows XP and its predecessors. 

Address Bar 
In a Web browser, the Address bar is where you type the addresses of the Web sites 
you want to visit. In an Explorer window, the Address bar is more of a «breadcrumbs 
bar" (a shout out to Hansel and Gretel fans). That is, it now shows the path you've 
taken-folders you burrowed through-to arrive where you are now (Figure 2-2). 

• •t Search 

Figurel-2: 
Top: The notation in the 
Address bar, Casey ► 
Pictures ► Halloween, 
indicates that you, 
Casey, opened your 
Personal folder (page 
38}; then opened the 
Pictures folder inside; 
and finally opened the 
Halloween folder inside 
that. 

,· ~ ll;.,...,, 

Bottom: If you press 
Alt+D, the Address 
bar restores the slash 
notation of Windows 
versions gone by, so 
that you can type in a 
different address. 
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There are three especially cool things about the new Vista Address bar: 

• It's much easier to read. Those ► little ► triangles are clearer separators of folder 
names than the older\slash\notation. And instead of drive letters like C:, you see 
the drive names. 

Tip: If the succession of nested folders' names is too long to fit the window, then a tiny « icon appears 
at the left end of the address. Click it to reveal a pop-up menu showing, from last to first, the other folders 
you've had to burrow through to get here. 

(The pop-up menu items that are supposed to be here-the list of recent places-appears in the same list, 
below a divider line.) 
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• It's clickable. You can click any breadcrumb to open the corresponding folder. For 
example, if you're viewing the Casey ► Pictures ► Halloween, you can click the word 
Pictures to backtrack to the Pictures folder. 

• You can still edit it. The Address bar of old was still a powerful tool, because you 
could type in a folder address directly ( using the slash notation). 

Actually, you still can. You can "open" the Address bar for editing in any of five 
different ways. (1) Press Alt+D. (2) Click the tiny icon to the left of the address. 
(3) Click any blank spot. (4) Right-click anywhere in the address; (5) From the 
shortcut menu, choose Edit Address. 

In each case, the Address bar changes to reveal the old-style slash notation, ready 
for editing (Figure 2-2, bottom). 

Tip: After you've had a good look, press Esc to restore the ► notation. 

Components of the Address bar 
On top of all that, the Address bar houses a few additional doodads that make it easy 
for you to jump around on your hard drive (Figure 2-3): 

· Back, Forward. Just as in a Web browser, the Back button opens whatever window 
you opened just before this one. Once you've used the Back button, you can then 
use the Forward button to return to the window where you started. Keyboard 
shortcuts: Alt+left arrow, Alt+right arrow. 

• Recent pages list. Click the .., ( to the left of the address box) to see a list of folders 
you've had open recently; it's like a multilevel Back button. 

• Recent folders list. Click the .., at the right end of the address box to see a pop-up 
menu listing addresses you've recently typed. 

· Contents list. This one takes some explaining, but for efficiency nuts, it's a gift 
from the gods. 

It turns out that the little ► next to each breadcrumb (folder name) is actually a 
pop-up menu. Click it to see what's in the folder name to its left. 

How is this useful? Suppose you're viewing the contents of the USA ► Florida ► 
Miami folder, but you decide that the folder you're looking for is actually in the 
USA ► California folder. Do you have to click the Back button, retracing your steps 
to the USA folder, only to then walk back down a different branch of the folder 
tree? No, you don't. You just click the ► that's next to the USA folder's name and 
choose California from the list. 

· Refresh ( double swirling arrows button). If you suspect that the window contents 
aren't up to date (for example, that maybe somebody has just dropped something 
new into it from across the network), click this button, or press FS, to make Vista 
update the display. 
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Explorer Window 
Controls 

· Search box. Type a search phrase into this box to find what you're looking for 
within this window. Page 119 has the details. 
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What to type into the Address bar 
When you click the tiny folder icon at the left end of the Address bar (or pressA1t+D), 
the triangle ► notation changes to the slash\notation, meaning that you can edit the 
address. At this point, the Address bar is like the little opening that lets you speak to 
the driver of a New York City taxi; you teU it where you want to go. Here's what you 
can type there (press Enter afterward) : 

Contents lists Figure 2-1: 

✓ UlffiePhotos 

Pictures 

Fall Cruise 

Pictures 

C.sey 

Picture5 

Cruise Photos 

from the Web 

Great Baby Pix 

St. Thomas panoramas 

O.\U~ Cu cy\Pic.turts\FIU Cruise 
• Casey 

Q\Users\Casey\Pidures 
C:\ Ums\Casey\Pictures.\St. Thom.1!. panoramas 
C:\ Users\Casey\Music 
htl '/ o.m tT11""..ofLcom/fwUrur/h.in.i:Jd=&J157 

Recent folders list 

The new Address bar 

SL Thomas panorama5 

Pictures 

is crawling with useful 
controls and dickable 
doodads. It may take 
you awhile to appreciate 
the difference between 
the little ~ to the left of 
the Address bar and the 
one to its right, though. 
The left-side one shows 
a list of folders you've 
had open recently; the 
right-side one shows ad­
dresses you've explicitly 
typed (and not passed 
through by dicking). 

C.sey 

Pictures 

Recent "pages" (places) list 

· A Web address. You can leave off the http:// portion. Just type the body of the Web 
address, such as www.sony.com, into this strip. When you press Enter ( or click the 
➔ button, called the Go button), Internet Explorer opens to the Web page you 
specified. 

Tip: If you press Ctrl+Enter instead of just Enter, you can surround whatever you've just typed into the Address 
bar with http,//wvvw and .com. See Chapter 11 for even more address shortcuts along these lines. 

• A search phrase. If you type some text into this strip that isn't obviously a Web 
address, Windows assumes that you're telling it, "Go online and search for this 
phrase." From here, it works exactly as though you've used the Internet search 
feature described on page 371. 

• A folder name. You can also type one of several important folder names into this 
strip, such as Computer, Documents, Music, and so on. When you press Enter, that 
particular folder window opens. 
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Optional Window 
Panes 

Search Pane 
Al; shown in Figure 2-1, the Search pane appears across the top of the window just 
below the Address bar. Of cornse, the Search box already appears in every Explorer 
vrindow, next to the Address bar-so why do you need a Search pane as well? 
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Name Otte.nlc~n T-191 

I (B Recently Changed 

More » 

Folders 

Pirusrts, 
~ crwc Photos 

swan 

sunset:2 

~ 
sunsetl 

JPEG Image 
Date taken: li6/2007 4:59 PM 

Tags: nature; vacations 

Navigation pane 

&nt&byPcc 

~ating: ~:-i;- •.: :-: :: ,; 
D1mensionsc: 1378xll43 

S~c.: 1.04MB 

Details pane Preview pane 

Figure2-4: 
Windows Vista hos 
you surrounded-or 
at least your Explorer 
windows. 

Use the Organize 
menu to summon or 
dismiss each of the 
optional pones that 
con line a window. 
A subtle outline 
appears around the 
icon for each pane 
you've summoned. 
Choose the name of 
a pane once to make 
it appear, and a sec­
ond time to hide it. 

Because the pane gives you a lot more control. It lets you specify more elaborate search 
criteria, including where you want Windows to look. Details are on page 1.20. 

Details Pane 
This strip appears at the bottom of the window, and it can be extremely useful. It 
reveals all kinds of information about whatever icon you've clicked in the main part 
of the window: its size, date, type, and so on. 
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Optional Window 
Panes 

Anyway, the Preview pane can be handy when you're examining pictures, text files, 
Office documents, PDF files, sounds, and movies. As you click each icon, you see 
a magnified thumbnail version of what's actually in that document. As Figure 2-5 
demonstrates, a controller lets you play sounds and movies right there in the Explorer 
window, without having to fire up Windows Media Player. (Cool.) 
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fill Docum ents 

g/i Mu ;ic 

~ Picturea; 

More» 

Folders 

f!J1Music 
El Pictures 
■ SavedGam6 

IIJ searches 
Stuff 

• Videos 

J.i Public 

Oesperh r 

II 
I Guess 

You're Right 

Love Comes Muita 

Figure2-5: 

Din Din Wo 
(Little Child) 

I Ka Barra 

~. 
~ ... 

(Your Work) 

• 
0Arv1' s Blues 

Bobeira -M~~=·,,,._ ___ .._ ___ -'==--------,--....,. ..... ----~ 

In many windows, 
the Preview pane 
can get in the way, 
because it shrinks 
the useful window 
space without 
giving you much 
useful information. 
But when you're 
browsing movies 
or sound files, it's 
awesome; it lets 
you play the music 
or the movie right 
in place, right in 
the window, with­
out having to open 
up a playback 
program. 

Muita Bobeira Artists: Lu ci.1na Sou?a: Romero - l cnflth: 00:02~2 
Windows Media Audio fil e A!bum: Duos II Ratin!:1 '.- 1 ..._. i L, ,..?' 

Grnr ,:,~ Latin 

Navigation Pane 
The Navigation pane has two halves: Favorite Links (the top part) and Folders (the 
bottom part). 

Favorite Links list 
The primary purpose of this area is to list places to which you want quick access. Since 
this pane will be waiting in every Explorer window you open, listing your favorite 
folders here can save you a lot of repetitive folder-burrowing. One click on a folder 
name opens the corresponding window. For example, click the Pictures icon to view 
the contents of your Pictures folder in the main part of the window (Figure 2-6). 

This list also offers icons for Recently Changed and Searches. These links refer to saved 
searches. You can read more about what they are and how they were created on page 
123. For now, it's enough to know that Recently Changed summons a quick list of 
everything on your hard drive that you've modified in the last 30 days, and Searches 
brings up a window filled with similar canned searches: Recent Documents, Recent 
E-mail, Shared By Me, and so on. 

The beauty of this parking lot for containers is that it's so easy to set up with your 
favorite places. For example: 
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Tags, Metadata, and 
Properties 

h ·,,orit~Lmks 

£; Piclu,es 

l[I Documents 

Ill Casey 
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ratings for music or pictures; in the row of five stars, click the rating star you want. 
Click the third star to give a song a 3, for example. 

Most usefully of all, you can edit the Tags box for any kind of icon. A tag is just a key­
word. It can be anything you want: McDuffy Proposal, Old Junk, Back Me Up-any­
thing. Later, you'll be able to round up everything on your computer with a certain 
tag, all in a single window, even though they physically reside in different folders. 

You'll encounter tags in plenty of other places in Vista-and in this book, especially 
when it comes to searching photos, and music. 

Nate: Weirdly, you can't add tags or ratings to BMP, PNG, AVI, or MPG files. 

Many of the boxes here offer autocompletion, meaning Vista proposes (in a pop-up 
menu) finishing a name or text tidbit for you if it recognizes what you've started to 
type. 

Tip: You can tag a bunch of icons at once. Just highlight them all (page 136) and then change the cor­
responding detail in the Details pane once. This is a great trick for applying a tag or star rating to a mass of 
files quickly. 

N.,.,,. 01Celllkm h !J' Sitt ltoting 

DSC_0086_1 OSC_0106_1 OSC_0119_1 OSC~0127 IMG_0085 

Foliage Camera maker. Nikon 

JPEG Image Camera model: 040 
Datetaken: 11/26/20065:20$1M Subject Stamforharbor 

Ta; i.: v11utloru: color:iut' Date created: 11/26/2006 4:22 PM /, 
,tct;ng:. ru.t.ianal monuments; ~t•mc>dd'icdl ll/26n006 5:22 PM { 

DsmtnJJOl'l~ l'\AlUtc; ~ ('..n{d 

kc; ; national monuments ~ 

Co~~; l,rtph::~:::,kbefo,e .. , ~~~ 

Properties 

Figure2-9: 
You can edit a lot 
of the background 
information that 
Windows stores 
about each icon on 
your PC. Click the 
information you 
want to change; if a 
text-editing box ap­
pears, you've hit pay 
dirt. Type away, and 
then press Enter (or 
dick the Save button 
at the lower-right 
corner of the dialog 
box). 

The Details pane shows some of the most important details about a file. But believe 
it or not, Windows actually stores even more behind-the-scenes metadata about every 
icon. If you really want to see the entire dossier for an icon, open its Properties dialog 
box using one of these tactics: 
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and bytes, is the cornerstone of the entire Windows religion. (Maybe that's why 
it's called an icon.) 

Wh at's especially cool .is that if you make your icons big enough, folder icons 
appear turned 90 degrees. Now, in real life, setting filing folders onto a desk that 
way would be idiotic; everything inside would tumble out in a chaotic mess. But 
in Windows-land, the icons within a folder remain exactly where they are. Bet­
ter yet, they peek out just enough so that you can see them. In the Music folder, 
for example, a singer's folder shows the first album cover within; a folder full of 
PowerPoint presentations shows the first slide or two; and so on. (You can see the 
effect in Figure 2-11.) 

Note: Because you can now view icons at any size you like, Microsoft has done away with the Thumbnails 
and Filmstrip views. 

Figure 2-11: 
The Views pop-up 
menu is a little 
weird; it actually 
has two columns. 
At right, it displays 
the preset view 
options for the 
files and folders in 
a window. At left, 
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a survey of the win­
dow views in Vista. 
From top left: Icon 
view (small), Icon 
view (large), List 
view, Details view, 
and Tiles view. 
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Uni-Window vs. 
Multi-Window 

Uni-Window vs. Multi-Window 
All Versions 
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0 oon'tStop 

itJ Go Your Own Way 

When you double-click a folder, Windows can react in one of two ways: 

• It can open a new window. Now you've got two windows on the screen, one over­
lapping the other. Moving or copying an icon from one into the other is a piece of 
cake. Trouble is, if your double-clicking craze continues much longer, your screen 
will eventually be overrun with windows, which you must now painstakingly close 
again. 

,::,, Sort ~Group 
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Figure 2-16: 
Top: There ore actually 
hundreds of photos in 
this folder. So where 
ore they all? They've 
been filtered out (hid­
den). You've asked 
Windows to show you 
only your five-star 
photos. 

Bottom: The filtering 
options may be very 
few or extensive. 
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earth-shattering isn't the adjective that springs to mind. Still, you may find one or 
two of them useful. 

Note: The changes you make in the Folder Options settings are global; they affect all Explorer windows. 

Here are the functions of the various checkboxes: 

, Always show icons, never thumbnails. Vista takes great pride in displaying your 
document icons as documents. That is, each icon appears as a miniature, a thumb­
nail, of the document itself-a feature that's especially useful in folders full of 
photos. 

On a slowish PC, this feature can really make your processor gasp for breath. 
If you notice that the icons are taking forever to appear, consider turning this 
checkbox on. 

• Always show menus. This checkbox forces the traditional Windows menu bar (File, 
Edit, View, and so on) to appear in every Explorer window, without your having to 
tap the Alt key. 

• Display file icon on thumbnails. Ordinarily, you can identify documents ( think 
Word, Excel, Power Point) because their icons display the corresponding logo (a 
big W for Word, and so on). But in Vista's icon views (Medium size and larger), 
you see the actual document on the icon-the actual image of the document's first 
page. So does that mean you can no longer tell at a glance what kind of document 
it is? 

Don't be silly. This option superimposes, on each thumbnail icon, a tiny "badge," 
a sub-icon, that identifies what kind of file it is. (It works on only some kinds of 
documents, however.) 

• Display file size information in folder tips. A folder tip is a rectangular balloon 
that appears when you point to a folder-a little yellow box that tells you what's 
in that folder and how big it is on the disk. (It appears only if you've turned on the 
"Show pop-up description" checkbox described below.) Talk about tweaky! You 
turn off this checkbox if you want to see only the description, but not the size. 

• Display simple folder view in Navigation pane. You know how Vista indents 
each more deeply nested folder in the Folders list, so more buried folders appear 
farther and farther to the right? Turn off this checkbox if you'd like to see verti­
cal dotted lines to designate each level of folder indenting, as in older versions of 
Windows. 

Note: The lines don't appear or disappear until the next time you open a window. 

• Display the full path in the title bar ( Classic folders only). Suppose you've rejected 
the millions of dollars and years of manpower Microsoft put in to Vista's new cos­
metic design. You've opted instead for the clunky old Classic theme (page 26). In 
that case, when this option is on, Windows reveals the exact location of the current 
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• When typing into list view. When you've got an Explorer window, teeming with 
a list of files, what do you want to happen when you start typing? 

In the olden days, that'd be an easy one: "Highlight an icon, of course!" That is, if 
you type piz, you'll highlight the file called Pizza with Casey.jpg. And indeed, that's 
what the factory setting means: "Select the typed item within the view." 

But Vista is a whole new ball game, and it has a whole new feature in every window: 
the Search box (page 119). If you turn on "Automatically type into the Search Box," 
then each letter you type arrives in that box, performing a real-time, letter-by-letter 
search of all the icons in the window. Your savings: one mouse click. 

Sizing, Moving, and Closing Windows 
All Versions 

Any Windows window can cycle among three altered states: 

· Maximized means that the window fills the screen; its edges are glued to the 
boundaries of your monitor, and you can't see anything behind it. It gets that way 
when you click its Maximize button (see Figure 2-1 )-an ideal arrangement when 
you're surfing the Web or working on a document for hours at a stretch, since the 
largest possible window means the least possible scrolling. Keyboard shortcut: Press 
Alt+Space bar, then X. 

At this point, the Maximize button has changed into a Restore Down button 
(whose icon shows two overlapping squares); click this to return the window to 
its previous size. Keyboard shortcut: Press Alt+Space bar, then R. 

Tip: Double-clicking the title bar-the big, fat top edge of a window- alternates a window between its maxi­
mized (full-screen) and restored conditions. 

• When you click a window's Minimize button (Figure 2-1 ), the window gets out of 
your way. It shrinks down into the form of a button on your taskbar, at the bottom 
of the screen. Minimizing a window is a great tactic when you want to see what's 
in the window behind it. 

You can bring the window back by clicking this taskbar button, which bears the 
window's name. On Aero machines, this button also displays a handy thumbnail 
miniature when you point to it without clicking, to remind you of what was in 
the original window. 

Keyboard shortcut: Press Alt+Space bar, then N. 

• A restored window is neither maximized nor minimized; it's a loose cannon, 
floating around on your screen as an independent rectangle. Because its edges 
aren't attached to the walls of your monitor, you can make it any size you like by 
dragging its borders. 
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• Its Close button glows red. (Background windows' Close buttons are transpar­
ent.) 

As you would assume, clicking a background window brings it to the front. 

Tip: And pressing Alt+Esc sends it to the back. Bet you didn't know that one! 

And what if it's so far back that you can't even see it? That's where Vista's window­
management tools come in; read on. 

Tip: For quick access to the desktop, clear the screen by clicking the Desktop button on the Quick Launch 
toolbar-its icon looks like an old desk blotter-or just press ll+D. Pressing that keystroke again brings all 
the windows back to the screen exactly as they were. 

Windows Flip (Alt+ Tab) 
All Versions 

In its day, the concept of overlapping windows on the screen was brilliant, innova­
tive, and extremely effective. In that era before digital cameras, MP3 files, and the 
Web, managing your windows was easy this way; after all, you had only about three 
of them. 

These days, however, managing all the open windows in all your open programs can 
be like herding cats. Off you go, burrowing through the microscopic pop-up menus 
of your taskbar buttons, trying to find the window you want. And heaven help you if 
you need to duck back to the desktop-to find a newly downloaded file, for example, 
or eject a disk. You'll have to fight your way through 50,000 other windows on your 
way to the bottom of the "deck." 

In Windows Vista, the same window-shuffling tricks are available that were available 
in previous editions: 

• Use the Taskbar. Clicking a button on the taskbar (page 92) makes the correspond­
ing program pop to the front, along with any of its floating toolbars, palettes, and 
so on. 

• Click the window. You can also bring any window forward by clicking any visible 
part of it. 

• Alt+ Tab. For years, this keyboard shortcut has offered a quick way to bring a dif­
ferent window to the front without using the mouse. If you press Tab while holding 
down the Alt key, a floating palette displays the icons of all running programs, as 
shown at the top in Figure 2-19. Each time you press Tab again (still keeping the Alt 
key down), you highlight the next icon; when you release the keys, the highlighted 
program jumps to the front, as though in a high-tech game of duck-duck-goose. 

This feature has been gorgeous-ized in Windows Vista, as shown in Figure 2-19. 
It's been renamed, too; it's now called Windows Flip. 
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Tip: If you just top Alt+ Tab without holding down the Alt key, you get an effect that's often even more use­
ful: you jump back and forth between the lost two windows you've had open. It's great when, for example, 
you're copying sections of a Web page into a Word document. 
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If your PC is capable of running Aero (page 22), Microsoft has something much slicker 
for this purpose: Flip 3D, a sort of holographic alternative to the Alt+ Tab trick. 

The concept is delicious. With the press of a keystroke, Vista shrinks all windows in 
all programs so that they all fit on the screen (Figure 2-20), stacked like the exploded 
view of a deck of cards. You flip through them to find the one you want, and you're 
there. It's fast, efficient, animated, and a lot of fun. 

Tip: You even see, among the other 3D "cards," a picture of the desktop itself. If you choose it, Vista minimizes 
all open windows and takes you to the desktop for quick access to whatever is there. 

Here's how you use it, in slow motion. First, press ::+ Tab. If you keep your thumb 
on the:: key, you see something like Figure 2-20. 

Keep your thumb on the:: key. At this point, you can shuffle through the "deck" of 
windows using any of these techniques: 

• Tap the Tab key repeatedly. (Add the Shift key to move backward through the 
stack.) 

• Press the down arrow key or the right arrow key. (Use the up or left arrow key to 
move backward.) 
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• Turn your mouse's scroll wheel toward you. (Roll it away to move backward.) 

When the window you want is in front, release the key. The 3-D stack vanishes, and 
the lucky window appears before you at full size. 

figure 2-20: 
These window 
miniatures aren't 
snapshots; they're 
"live. " That is, if 
anything is chang­
ing inside a window 
(a movie is playing, 
for example), you'll 
see it right on the 
JD miniature. 

By the way: Don't 
miss the cool slow­
mo trick described 
in Appendix B. 

Flip 3D Without Holding Down Keys 
That Flip 3D thing is very cool, but do you really want to exhaust yourself by keeping 
your thumb pressed on that:: key? Surely that's an invitation to getting the painful 
condition known as Nerd's Thumb. 

Fortunately, you can also use Flip 3D without holding down keys. You can trigger it 
using any of these three methods: 

• The Quick Launch toolbar (page 101) comes preinstalled with a tiny icon that, 
when you point to it, identifies itself as "Switch between windows." Click it. 

• Add the Ctrl key to the usual keystroke. That is, press:: +Ctrl+ Tab. This time, 
you don't have to keep any keys pressed. 

• Press the Flip 3D key on your keyboard, if it has one. 

Any of these tactics triggers the 3-D floating-windows effect shown in Figure 2-20. 
At this point, you can use the arrow keys or your mouse's scroll wheel to flip through 
the open windows without having to hold down any keys. When you see the one you 
want, press the Esc key to choose it and bring it to the front. 
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• To minimize all the windows in one fell swoop, right-click a blank spot on the 
taskbar and choose Show the Desktop from the shortcut menu-or just press 
::+D. 

Tip: When the taskbar is crowded with buttons, it may not be easy to find a blank spot to click. Usually 
there's a little gap near the right end; you can make it easier to find some blank space by enlarging the 
taskbar, as described on page 98. 

• If you change your mind, the taskbar shortcut menu always includes an Undo 
command for the last taskbar command you invoked. (Its wording changes to 
reflect your most recent action-"Undo Minimize All;' for example.) 

The Quick Launch Toolbar 
At the left end of the taskbar-that is, just to the right of the Start button-is a 
handful of tiny, unlabeled icons. This is the Quick Launch toolbar, one of the most 
useful features in Windows. For details on this toolbar and the others in Windows 
Vista, see page 98. 

Customizing the Taskbar 
You're not stuck with the taskbar exactly as it came from Microsoft. You can resize 
it, move it, or hide it completely. Most people don't bother, but it's always good to 
know what options you have. 

Moving the taskbar 
You can move the taskbar to the top of your monitor, or, if you're a true rebel, to 
either side. 

To do so, first ensure that the toolbar isn't locked (which means that you can't move 
or resize the taskbar-or any of its toolbars, for that matter). Right-click a blank spot 
on the taskbar to produce the shortcut menu. If"Lock the taskbar" is checked, select 
it to make the checkmark disappear. 

Now you can drag the taskbar to any edge of the screen, using any blank spot in the 
central section as a handle. Release the mouse when the taskbar leaps to the edge 
you've indicated with the cursor. 

When the taskbar is on the left or right edge of the screen, Windows Vista widens it 
automatically so that you can read the button names, which remain horizontal. In 
truth, this isn't a bad idea, considering your screen probably has more unused space 
horizontally than vertically. (Ergonomic studies have indicated that keeping your neck 
bent at a 90 degree angle to read vertical buttons isn't so hot for your spine.) 

Tip: No matter which edge of the screen holds your taskbar, your programs are generally smart enough to 
adjust their own windows as necessary. In other words, your Word document will shift sideways so that it 
doesn't overlap the taskbar that you've dragged to the side of the screen. 
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help group for people who spend entirely too much time fiddling with this kind of 
thing.) 

To make a toolbar appear or disappear, right-click a blank spot on the taskbar 
and choose from the Toolbars submenu that appears (Figure 2-26). The ones with 
checkmarks are the ones you're seeing now; choose one with a checkmark to make 
the toolbar disappear. 

Here's a rundown of the ready-made taskbar toolbars at your disposal. 

Figure 2-26: 
Top: Make too/bars 
appear by right-clicking 
a blank area on the 
taskbar, if you can find 
one. 

Bottom: Too/bars eat 
into your taskbar space, 
so use them sparingly. If 
you've added too many 
icons to the too/bar, 
a >> button appears 
at its right end. Click it 
to expose a list of the 
commands or icons that 
didn't fit. 
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Properties 

Control Panel 

Recycle Bin 

HotToonz 

This toolbar offers a duplicate copy of the Address bar that appears in every Explorer 
window, complete with a Recent Addresses pop-up menu-except that it appears in 
the taskbar at all times. That way, it's always available, even if no Explorer window 
happens to be open. 

Windows Media Player Toolbar 
You may be a bit baffled when you choose this one's name from the Toolbars list-and 
nothing happens. 
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That's because this toolbar only deigns to make itself visible when (a) you're actually 
running Windows Media Player ( Chapter 14), and (b) you've then minimized it. Only 
then do you see the full glory of the Windows Media Player Toolbar. 

Links Toolbar 
From its name alone, you might assume that the purpose of this toolbar is to provide 
links to your favorite Web sites. And sure enough, that's one thing it's good for. 

But in fact, you can drag any icon at all onto the toolbar-files, folders, disks, programs, 
or whatever-to turn them into one-click buttons. In short, think of the Links toolbar 
as a miniature Start menu for places and things you use most often. 

Here are a few possibilities, just to get your juices flowing: 

• Install tool bar icons of the three or four programs you use the most ( or a few 
documents you work on every day). Sure, the Start menu and the Quick Launch 
toolbar can also serve this purpose, but only the Links toolbar keeps their names 
in view. 

• Install toolbar icons for shared folders on the network. This arrangement saves 
several steps when you want to connect to them. 

• Install tool bar icons of Web sites you visit often, so that you can jump directly to 
them when you sit down in front of your PC each morning. (In Internet Explorer, 
you can drag the tiny icon at the left end of the Address bar directly onto the Links 
toolbar to install a Web page there.) 

You can drag these links around on the toolbar to put them into a different order, or 
remove a link by dragging it away-directly into the Recycle Bin, if you like. (They're 
only shortcuts; you're not actually deleting anything important.) To rename something 
here-a good idea, since horizontal space in this location is so precious-right-click 
it and choose Rename from the shortcut menu. 

Tip: Dragging a Web link from the Links toolbar to the desktop or an Explorer window creates an Internet 
shortcut file. When double-clicked, this special document connects to the Internet and opens the specified 
Web page. 

Tablet PC Input Panel 
This toolbar is useful only if you're working on a Tablet PC, which has a touch screen 
and stylus. It provides quick access to Vista's handwriting-recognition software. 
Chapter 19 has the details. 

Desktop Toolbar 
The Desktop toolbar (Figure 2-26, bottom) offers quick access to whichever icons 
are sitting on your desktop-the Recycle Bin, for example, and whatever else you've 
put there. As a convenience, it also lists a few frequently-used places that aren't on the 
desktop, including Internet Explorer and the Control Panel ( complete with a pop-up 
menu that lists the individual Control Panel applets for even faster access). 
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Chances are that you don't speak all of the world's useful languages, though. So the 
idea here is to install the software necessary only for the languages and layouts you 
do use (see the box on the facing page). After that, you can use the Language bar to 
switch among them with a quick click. 

Redesigning Your Toolbars 
To change the look of a toolbar, right-dick any blank spot within it. 

Tip: How much horizontal taskbar space a tool bar consumes is up to you. Drag the border at the left edge 
of a tool bar to make it wider or narrower. That's a good point to remember if, in fact, you can't find a blank 
spot to right-click. 

The resulting shortcut menu offers these choices, which appear above the usual taskbar 
shortcut menu choices: 

• View lets you change the size of the icons on the tool bar. 

• Open Folder works only with the Quick Launch and Links toolbars. 

It turns out that the icons on these toolbars reflect the contents of corresponding 
folders on your PC. To see one, right-dick a blank spot on the toolbar itself; from 
the shortcut menu, choose Open Folder. 

Why is that useful? Because it means that you can add, rename, or delete icons en 
masse, by working in the folder instead of on the toolbar itself. Of course, you can 
also delete or rename any icon on these toolbars by right-clicking it and choosing 
Delete or Rename from the shortcut menu. But a window isn't nearly as claustro­
phobic as the toolbar itself. 

· Show Text identifies each toolbar icon with a text label. 

· Show Title makes the toolbar's name ( such as "Quick Launch" or "Desktop") appear 
on the toolbar. 

• Close Toolbar makes the toolbar disappear. 

Build Your Own Toolbars 
The Quick Launch area of the taskbar is such a delight that you may actually develop 
a syndrome called Quick Launch Envy-you'll find that having only one isn't enough. 
You might wish to create several different Quick Launch toolbars, each stocked with 
the icons for a different project or person. One could contain icons for all the chapters 
of a book you're writing; another could list only your games. 

Fortunately, it's easy to create as many different custom toolbars as you like, each of 
which behaves exactly like the Quick Launch toolbar. 

Windows creates toolbars from folders; so before creating a toolbar of your own, you 
must create a folder and fill it with the stuff you want to toolbarize. 
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Meet Vista Search 
All Versions 

Every computer offers a way to find files. And every system offers several different 
ways to open them. But Search, a star feature of Vista, combines these two functions 
in a way that's so fast, so efficient, and so spectacular, it reduces much of what you've 
read in the previous chapters to irrelevance. It works like Google Desktop ( or Spotlight 
on the Macintosh), in that it finds files as you type what you're looking for-not like 
Windows XP, which doesn't start searching until you're finished typing, and takes a 
very long time to find things at that. 

It's important to note, though, that you can search for files on your PC using the 
superfast Search box in two different places: 

• The Start menu. The Start Search box at the bottom of the Start menu searches 
everywhere on your computer. 

• Explorer windows. The Search box at the top of every desktop window searches 
only that window (including folders within it). You can expand it, too, into some­
thing called the Search pane-a way to limit the scope of your search to certain 
file types or date ranges, for example. 

Search boxes also appear in the Control Panel window, Internet Explorer, Windows 
Mail, Windows Media Player, and other spots where it's useful to perform small-time, 
limited searches. The following pages, however, cover the two main Search boxes, the 
ones that hunt down files and folders. 

Search from the Start Menu 
All Versions 

Start by opening the Start menu, either by using the mouse or by pressing the :: 
key. 

The Start Search text box appears at the bottom of the Start menu; you can imme­
diately begin typing to identify what you want to find and open (Figure 3-1). For 
example, if you're trying to find a file called "Pokemon Fantasy League.doc," typing 
just pok or leag will probably work. 

Tip: This one's for you, power users. You can also type command-line prompts into the Search box, like 
control date/time to open your Date & Time control panel or ping nytimes.com to see if your machine can 
reach the outside world. See page 255 for more on the command prompt. 

As you type, the familiar Start menu items disappear, and are soon replaced by search 
results (Figure 3-1, bottom). This is a live, interactive search; that is, Vista modifies 
the menu of search results as you type-you do not have to press Enter after entering 
your search phrase. 

The results menu lists every file, folder, program, email message, address book entry, 
calendar appointment, picture, movie, PDF document, music file, Web bookmark, 
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an outgoing email message, a presentation, or a Web page you're designing. (In 
a page-layout program, for example, use the Insert command, and then use the 
Search box that appears at the top of the Open dialog box.) 

• If you point to an item in the results menu without clicking, a little tooltip box 
appears. It tells you the item's actual name and its folder path (that is, where it is 
on your hard drive). 

You can also jump to a search result's actual icon, sitting there in its actual window, 
instead of opening it. To do that, right-dick its name, and, from the shortcut menu, 
choose Open File Location. 

• At the bottom of the results menu, the "Search the Internet," of course, opens up 
your Web browser and searches the Web for your search term, using Google or 
whatever search site you've designated as your favorite. 

Tip: If, for some inconceivable reason, you don't actually like having the mind-blowing ability to find anything 
on your PC in seconds, right from the Start menu, without ever taking your hands from the keyboard-surely 
there's someone who doesn't-you can get rid of the Start Search box. Right-click the Start menu; from the 
shortcut menu, choose Properties. Cl ick Customize and, in the resulting dialog box, turn off "Search box." 
Click OK twice. 

What Vista Knows 
The beauty of Vista's Search is that it doesn't just find files whose names match what 
you've typed. That would be so 2004! 

No, Vista actually looks inside the files. It can actually read and search the contents of 
text files, email, Windows Contacts, Windows Calendar, RTF and PDF documents, 
and documents from Microsoft Office (Word, Excel, and Power Point). 

But that's only the beginning. Vista searches files not only for the text inside them, 
but also over 115 other bits of text-a staggering collection of informational tidbits 
including the names of the layers in a Photoshop document, the tempo of an MP3 file, 
the shutter speed of a digital-camera photo, a movie's copyright holder, a document's 
page size, and on and on. 

Technically, this sort of secondary information is called metadata. It's usually invisible, 
although a lot of it shows up in the Details pane described in Chapter 2. 

You might think that typing something into the Search box triggers a search. But to be 
technically correct, Vista has already done its searching. In the first 15 to 30 minutes 
after you install Vista-or in the minutes after you attach a new hard drive-Vista 
invisibly collects information about everything on your hard drive. Like a kid cram­
ming for an exam, it reads, takes notes on, and memorizes the contents of all of your 
files. 

WINDOWS VISTA: THE MISSING MANUAL 



It stores all of this information in an invisible, multimegabyte file called, creatively 
enough, the index. (lf your primary hard drive is creaking full, you can specify that 
you want the index stored on some other drive; see page 118.) 

Once it has indexed your hard drive in this way, Vista can produce search results 
in seconds. It doesn't have to search your entire hard drive-only that single card­
catalog index file. 

After the initial indexing process, Vista continues to monitor what's on your hard 
drive, indexing new and changed files in the background, in the microseconds between 
your keystrokes and clicks. 

Where Vista Looks 
Start-menu searches don't actually scrounge through every last file on your computer. 
Searching inside Windows's own operating-system files and your software applica­
tions, for example, would be pointless to anyone but programmers, so Vista doesn't 
bother. 

What it does index is everything in your Personal folder (page 38): email, pictures and 
music, videos, program names, entries in your address book and calendar, Office docu­
ments, and so on. It also searches offline files that belong to you, even though they're 
stored somewhere else on the network ( page 589). Finally, it searches the Start menu. 
You can, if you wish, add other folders to the list of indexed locations (page 117). 

In an effort to keep searches fast ( and hold down the size of the invisible index file), 
Vista doesn't index Windows system files and application support files. It indexes all 
the drives connected to your PC, but not other hard drives on the network. 

It does index the Personal folders of everyone else with an account on your machine 
(Cha_pter 23), but you're not allowed to search them from the Start menu .. So if you 
were hoping to search your spouse's email for phrases like "meet you at midnight;' 
forget it. 

If you try to search anywhere that Windows hasn't incorporated into its index-in 
a Windows system folder, for example, or a hard drive elsewhere on the network-a 
message appears. It lets you know that because you're working beyond the index's 
wisdom, the search is going to be slow, and the search will include file names only-not 
file contents or metadata. 

Furthermore, this kind of outside-the-index searching does not find things as you 
type. This time, you really do have to press Enter after typing the name (or partial 
name) of what you want to find. 

The Results Window 
As you may have noticed, the Vista menu doesn't list every match on your hard drive. 
Unless you own one of those extremely rare 60-inch Skyscraper Displays, there just 
isn't room. 
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Instead, Vista uses some fancy behind-the-scenes analysis to calculate and display 
the 20 most likely matches for what you typed. But at the bottom of the menu, a link 
called "See all results" is a reminder that there may be many other candidates. Click 
it to open the results window, shown in Figure 3-2. 
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You can open this 
window (bottom) by 
clicking a link called 
"See all results" in the 
Start menu's results list 
(top). (If Vista found no 
matches for your search, 
you don't get a "See all 
results" link-instead, 
you get a "Search 
Everywhere" link that 
expands the scope of 
your search.) 
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Now you have access to the complete list of matches, listed in typical Explorer-win­
dow format. You can sort this list, group, stack, or filter it exactly as described in 
Chapter 2. 

The only difference is that the task toolbar (Organize, Views, and so on) offers a few 
useful buttons that don't usually adorn standard folder windows, like Save Search and 
Search Tools. Details on these buttons appear later in this chapter. 
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searches your entire computer. The Search box in an Explorer window searches only 
this window (and folders within it). 

As you type, the window changes to show search results as you type into the Search 
box, much the way the Start menu changes. As described on pages 109-110, a whole 
range of power tips is available to you, including file-type searches, AND searches, 
OR searches, and so on. 

Once the results appear, you can sort, filter, group, and stack them just like the icons 
in any other Explorer window. 

The Search Pane 
As described in Chapter 2, you can adorn every Explorer window with up to four 
different panes-inch-wide strips at the left, right, top, and bottom of a window. One 
of them is the Search pane. 

You can get to it in several ways: 

• Press l:+F, which is the keyboard shortcut for the Search window (for find, get 
it?). 

• When the Computer window is open (Start➔Computer), choose Organize➔ 
Layout➔Search pane (Figure 3-6, top). 

• After a regular Explorer-window search, open the Search Tools menu that now 
appears in the task toolbar. Choose Search Pane. 

• After a regular Explorer-window search, click Advanced Search at the bottom of 
the results list (Figure 3-6). 

In the first three cases, you see only the top of the Advanced Search pane-the "Show 
only:" toolbar described below. To see the full range of options, click Advanced Search 
at the right end of the "Show only:" toolbar. 

As you can see in Figure 3-6, the Search pane lets you fine-tune the search by adding 
controls like these: 

· Show only: Vista is ordinarily an extremely passionate little fetcher. It shows you 
every file of every type it knows when you do a search. Often, though, it displays 
too much information. If you know what you're looking for is an email message, 
document, picture, or music file, click the corresponding button. Your search will 
reveal only the kind of file you asked for. For example, when you're trying to free 
up some space on your drive, you could round up all your gigantic photo files. 
("Other," here, means everything except email, documents, pictures, or music.) 

• Location. The choices in this pop-up menu-Everywhere, Indexed Locations, 
Computer, Local Hard Drives, and so on-affect the scope of your search. 
Remember: Ordinarily, searching in an Explorer window finds icons only within 
the open window, including what's in its subfolders. But using this pop-up menu, 
you can make an Explorer-window search do what a Start-menu search always 
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does: search your entire computer. Or only your main hard drive. Or all hard 
drives. Whatever. 

In fact, if you choose "Choose search locations" from this pop-up menu, you get 
a collapsible, flippy-triangle list of every disk and folder associated with your PC 
(Figure 3-7). Checkboxes give you complete freedom to specify any crazy, mixed­
up assortment of random folders you'd like to search at once. 

Tip: This option is especially useful when you want to search other hard drives on your network. 

At the bottom of this pop-up menu, by the way, is a list of folders you've recently 
searched, for your deja vu pleasure. 

• Date modified/ created. When you choose one of these options from the first pop­
up menu, the second and third pop-up menus let you isolate files, programs, and 
folders according to the last time you changed them or when they were created. 

FigureJ-6: 
You can gain much 
more control over the 
search process using the 
Search pane. 

Top: One way to make 
it appear is to choose 
"Search pane" from 
the Search Tools menu, 
which appears after 
you perform a regular 
Explorer-window search. 
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Higgins pro~osal, a~d burn them onto a CD. A search folder can do the rounding-up 
part with a smgle click. 

Saved Searches 
(Search Folders) 

So you open an Explorer window, open its Advanced Search pane, and set up the 
Authors text box with an OR search (page 110). Type Higgins into the Tags box. (Of 
course, you've been painstakingly tagging your documents with tags and author names, 
in readiness for this glorious moment.) You click Save Search. You name the search 
folder something like Our Higgins Files, and save it to your hard drive (Figure 3-9). 

Figure J-9: 
Vista can preserve your 
search as a search 
folder, a saved search 
that does its duties 
instantly every time you 
"open" the folder. 

Top: First, set up the 
search using the usual 
controls. Click the Save 
Search button shown 
here. 

Middle: Save the search 
folder wherever you 
like, but it'll be easy to 
find it if you stash it in 
the Searches folder, as 
Windows is suggesting 
here. 

Bottom: Your search 
folder is ready to use! 
It's right here in the 
Searches folder, whose 
icon appears in the 
Favorite Links list at 
the left side of every 
window. 
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From now on, whenever you open that search folder, it opens to reveal all of the files 
you've worked on that were tagged with Higgins and written by you or your partner. 
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Dragging icons into the Navigation pone 
You may find it easier to copy or move icons using the Navigation pane (page 66), 
since the two-pane display format makes it easier to see where your files are and 
where they're going. 

Figure J-IJ: 
Thanks to this 
shortcut menu, 
right-dragging 
icons is much 
easier and safer 
than left-dragging 
when you want 
to move or copy 
something. New 
in Vista: the handy 
numeric "badge" 
on your cursor, 
which reminds you 
how many things 
you're about to 
move or copy. 

Just expand the flippy triangles of the Navigation pane until you can see the destina­
tion folder. Then locate the icon you want to move in the right pane and drag it to the 
appropriate folder in the left pane (Figure 3-14). Windows copies the icon. 

Figure J-14: 
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Shortcut Icons 
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their icons onto the Start button or the Quick Launch toolbar. In fact, everything 
listed in the Start➔All Programs menu is a shortcut. So is every link in the top part 
of your Navigation pane. 

Tip: Don't confuse the term shortcut which refers to one of these duplicate-icon pointers, with shortcut 
menu, the context-sensitive menu that appears when you right-click almost anything in Windows. The 
shortcut menu has nothing to do with the shortcut icons feature; maybe that's why it's sometimes called 
the context menu. 

Creating and Deleting Shortcuts 
To create a shortcut, right-drag an icon from its current location to the desktop. 
When you release the mouse button, choose Create Shortcuts Here from the menu 
that appears. 

Tip: If you're not in the mood for using a shortcut menu, just left-drag an icon while pressing Alt. A shortcut 
appears instantly. (And if your keyboard lacks an Alt key-yeah, right-drag while pressing Ctrl+Shift instead.) 

You can delete a shortcut the same as any icon, as described in the Recycle Bin dis­
cussion earlier in this chapter. (Of course, deleting a shortcut doesn't delete the file 
it points to.) 

Unveiling a Shortcut's True Identity 
To locate the original icon from which a shortcut was made, right-dick the shortcut 
icon and choose Properties from the shortcut menu. As shown in Figure 3-17, the 
resulting box shows you where to find the "real" icon. It also offers you a quick way 
to jump to it, in the form of the Find Target button. 

Shortcut Keyboard Triggers 
Even after reading all of this gushing prose about the virtues of shortcuts, efficiency 
experts may still remain skeptical. Sure, shortcuts let you put favored icons everywhere 
you want to be, such as your Start menu, Quick Launch toolbar, the desktop, and so 
on. But they still require clicking to open, which means taking your hands off the 
keyboard-and that, in the grand scheme of things, means slowing down. 

Lurking within the Shortcut Properties dialog box is another feature with intrigu­
ing ramifications: the Shortcut Key box. By clicking here and then pressing a key 
combination, you can assign a personalized keystroke for the shortcut. Thereafter, 
by pressing that keystroke, you can summon the corresponding file, program, folder, 
printer, networked computer, or disk window to your screen (no matter what you're 
doing on the PC). 

Three rules apply when choosing keystrokes to open your favorite icons: 

• The keystrokes work only on shortcuts stored on your desktop or in the Start menu. 
If you stash the icon in any other folder, the keystroke stops working. 
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Tip: If you store pictures in a folder other than Pictures, you can still use them. That's what the Browse button 
is fo r. Click it to select the folder and make its contents appear as thumbnail wallpaper candidates. 

Beneath the thumbnails, by the way, Microsoft asks a very good question: "How should 
the picture be positioned?" What it means, actually, is, "How should the picture be 
positioned if it's too small to fill your screen?" 

Your choices are (as represented by the mini-pictures): 

• Fit to screen. Stretch the picture to fit the desktop, even if distortion may result. 

·Tile.Place the picture in the upper-left corner of the desktop, and repeat it over 
and over until the entire desktop is covered. 

· Center. Plop the picture in the middle of the desktop. If the picture is smaller than 
the desktop, a colored border fills in the gaps. (You can change the border color by 
clicking the little "Change background color" link that appears when you choose 
the Center option.) 

Once you have chosen your desktop picture, and the way it will be positioned, apply 
your new desktop by clicking OK. 

Screen Savers 
All Versions 

You don't technically need a screen saver to protect your monitor from burn-in. 
Today's energy-efficient monitors wouldn't burn an image into the screen unless you 
left them on continuously, unused, for at least two years, according to the people who 
design and build them. 

No, screen savers are mostly about entertainment, pure and simple-and Windows 
Vista's built-in screen saver is certainly entertaining. 

GEM IN THE ROUGH 

Wehby Wallpaper 

If there's a graphic on the Web that strikes your fancy, it can 
become wallpaper, too. Right-click the image-right there in 
your Web browser-and choose Set as Background (or Set 
as Wallpaper) from the shortcut menu. The graphic moves 
immediately to the middle of your desktop. (You'll probably 
have to close or minimize your browser window to see it.) 

Windows Vista saves the file in an invisible folder (your 
Personal➔AppData➔Roaming➔Microsoft➔lnternet 

Explorer folder, if you must know). Windows names it 

Internet Explorer Wal/paper.bmp. (If you use a Firefox 
browser, the file is called Firefox Wal/paper.bmp and lands 
in the Mozilla➔Firefox folder instead of the Microsoft➔ 
Internet Explorer folder.) If you find another Web graphic you 
like and want to repeat the steps to turn it into wallpaper, be 
aware that Windows Vista saves the new file with the same 
name, replacing the original file. To have access to both 
files, change the name of the previous wallpaper file before 
grabbing a new image. 
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Screen Savers The idea is simple: A few minutes after you leave your computer, whatever work you 
were doing is hidden behind the screen saver; passers-by can't see what's on the screen. 
To exit the screen saver, move the mouse, click a mouse button, or press a key. 
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Tip: Moving the mouse is the best way to get rid of a screen saver. A mouse click or a key press could trig­
ger an action you didn't intend-such as clicking some button in one of your programs or typing the letter 
whose key you pressed. 

Choosing a Screen Saver 
To choose a Windows Vista screen saver, right-click the desktop. From the shortcut 
menu, choose Personalize. In the resulting window, click Screen Saver. 

Now use the Screen Saver drop-down list. A miniature preview appears in the preview 
monitor on the dialog box (see Figure 4-5). 

"5 Screen S.aver Settings 
Figure 4-5: 
Some screen savers don't work 
unless you have an Aero-capable 
PC (page 22): Windows Energy, Rib­
bons, Mystify, Bubbles, Aurora, and 
JO Text. If you don't have an Aero 
machine, you're left with slim pick­
ings. Of course, the photo sample 
pictures are nice. (If you have an 
Aero-capable PC but you've turned 
off the Aero look, the fancy screen 
savers are still available.) 
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To see a full-screen preview, click the Preview button. The screen saver display fills 
your screen and remains there until you move your mouse, click a mouse button, or 
press a key. 
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• Beginning any utterance with "How do I" opens up Windows Help; the next part 
of your sentence goes into the Search box . 

• "Computer" forces the interpretation of your next utterance as a command; "Insert" 
forces it to be transcribed . 

• Out of the box, Speech Recognition puts two spaces after every period-a very 
1980s thing to do. Nowadays, that kind of gap looks a little amateurish. Fortunately, 
you can tell Speech Recognition to use only one space. 

Making this change requires you to visit the little-known Advanced Speech Options 
dialog box. Choose Start➔Control Panel. in Classic view, open Speech Recognition 
Options. In the task pane at left, click ''Advanced speech options" (Figure 6-9). 

The Sidebar 
All Versions 

As you know, the essence of using Windows is runningprograms, which often produce 
documents. In Vista, however, there's a third category: a set of weird hybrid entities 
that Microsoft calls gadgets. They appear, all at once, floating in front of your other 
windows, at the right side of the screen. They're there when you .first .fire up Vista, or 
whenever you press ::+Space bar. (You can also open them by choosing Start➔All 
Programs➔Accessories➔ Windows Sidebar.) 

Welcome to the new world of the Sidebar (Figure 6-10). 

What are these weird hybrid entities, anyway? They're not really programs, because 
they don't create docume1,ts or have listings in the All Programs menu. They're cer­
tainly not documents, because you can't name or save them. What they most resemble, 
actually, is little Web pages. They're meant to display information, much of it from 
the Internet, and they're written using Web programming languages like DHTML, 
Javascript, VBScript, and XML. 

Note: They're generally distributed as .zip files that, when decompressed, have the filename extension 
.gadget. 

Vista's starter gadgets include a calculator, current weather reporter, stock ticker, clock, 
and so on. Mastering the basics of Sidebar won't take you long at all: 

• To move a gadget, drag it around the screen. It doesn't have to stay in the Sidebar 
area. 

In fact, you can drag all of the gadgets off the Sidebar, if you like, and park them 
anywhere on the screen. You could even close the now-empty Sidebar- right­
click a blank spot and, from the shortcut menu, choose Close Sidebar-and leave 
the gadgets themselves stranded, floating in place. (If they look too lonely, you 
can reopen the Sidebar by right-clicking the tiny Windows Sidebar icon in your 
notification area and, from the shortcut menu, choosing Open.) 
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The Sidebar 
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Tip: If the gadget doesn't seem to want to move when you drag it, you're probably grabbing it by a clickable 
portion. Try to find a purely graphical spot-the spiral binding of the calendar, for example. 

And if all else fails, right-click the gadget. From the shortcut menu, choose Detach from Sidebar. 

• To close a gadget, point to it. You'll see the square X button appear at the gadget's 
top-left corner; click it. (You can also right-dick a gadget and choose Close Gadget 
from its shortcut menu.) 

• To add a gadget to the Sidebar, click the + button at the top of the screen (Figure 
6-10), or right-dick any gadget (or the Sidebar notification-area icon) and choose 
Add Gadget from the Sidebar. 

You've just opened the Gadget Gallery, a semi-transparent catalog of all your gad­
gets, even the ones that aren't currently on the screen (Figure 6-11). Open one by 
double-clicking its icon, or by dragging it to a blank spot on your Sidebar. 

Fix ceifi"!J 

Pick up so.fst> 

(i!JM 3:00 pw, 

Figure 6-10: 
When you summon the Sidebar, you get a fleet of floating minipro­
grams that convey or convert all kinds of useful information. They 
appear and disappear all at once, on a tinted translucent sheet. 
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If you add more gadgets than can fit on the Sidebar, a tiny ► appears at the top of 
the Sidebar. Click it to bring the next "page" full of gadgets into view. 

, To rearrange your gadgets within the Sidebar, just drag them up or down, using 
any blank spot as a handle. The other gadgets slide out of the way. 

Figure 6-11: 
You may have to 
scroll the Gadget 
Callery to see all 
the gadgets, by 
clicking the Page 
arrows at the top 
left of the window. 
When you're 
finished opening 
new gadgets, close 
the Gadget Callery 
by clicking its X 
button. 
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Losing the Sidebar 
To get rid of the Sidebar, you have several options. 

• Hide it by right-clicking a blank spot on the Sidebar. From the shortcut menu, 
choose Close Sidebar. 

This technique just hides the actual Sidebar rectangle. It doesn't close any gad­
gets that you've moved onto your screen, and it's still technically running, using 
memory. 

• Quit it completely, so it's not using up memory or distracting you, by right­
clicking the Windows Sidebar notification-area icon. From the shortcut menu, 
choose Exit. 

• Make it stop auto-starting along with Windows by opening the Windows Sidebar 
Properties control panel. (Quickest way: Right-click the Windows Sidebar icon 
in your notification area. From the shortcut menu, choose Properties.) Turn off 
"Start Sidebar when Windows starts." Click OK. 

Sidebar Tips 
Like most new Vista features, Sidebar is crawling with tips and tricks. Here are a few 
of the biggies: 

• You can open more than one copy of the same gadget. Just double-click its icon 
more than once in the Gadget Bar. You wind up with multiple copies of it on your 
screen: three Clocks, two Weather trackers, or whatever. That's a useful trick when, 
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to the MSN Money Web site, already opened to a details page about that currency 
and its history . 

• Convert more currencies at once by clicking the + button (lower-right of the 
gadget). That is, you can see $20 represented as dinar, baht, and shekels simultane­
ously. 

, Find out where the data comes from by clicking the words Data Providers. 

Note: This gadget actually does its homework. It goes on line to download up-to-the-minute currency rates 
to ensure that the conversion is accurate. 

Feed Headlines 
An RSS feed is a newfangled Internet feature, in which the headlines from various 
Web sites are sent to you automatically (see page 380 for details) . Internet Explorer 7 
can accept RSS feeds, of course-but you don't have to fire it up every time you want 
to know the news of the world. Just take a look at this little gadget. 

Actually, don't look yet; out of the box, this gadget doesn't show much at all. But if you 
click its "View headlines" link, you get to see 100 recent headlines, all from Microsoft 
sources: Microsoft news, Microsoft tips, Microsoft articles, and so on. 

• Substitute your own feeds. This gadget is much more attractive when you fill it with 
your own favorite feeds-the New York Times, sports-score sites, favorite online 
columnists, and so on. Fortunately, the gadget inherits its list of feeds from those 
you've subscribed to in Internet Explorer, as described on page 380. 

Once you've subscribed to a feed there, click this gadget's Options (wrench) button. 
Use the "Display this feed" list to choose the feed you want displayed. 

Tip: You can choose only one item from the "Display this feed" pop-up menu. Fortunately, that doesn't 
mean only one feed. If you take the effort to create a folder for your favorite feeds when storing them in 
Internet Explorer, you can choose that folder's name in this gadget, thereby getting a rotating list of multiple 
favorite feeds. 

• Scroll the list by clicking the the ... or " buttons. 

• See more of each headline by dragging this gadget off the sidebar, if you've got the 
room. 

Notes 
Notes is a virtual Post-it note that lets you type out random scraps of text-a phone 
number, a Web address, a grocery list, or whatever. 

• Edit the note by typing away. Right-click to access Cut, Copy, and Paste commands. 

• Add another page by clicking the+ button (lower right); delete the current page 
by clicking the X button (lower left). Once you have more than a single page, use 
the ◄ or ► buttons to move among them. 
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• Change the paper color, font, or size by clicking the Options button ( tiny wrench) 
at the right side of the gadget. Font and Size controls appear there; click the ◄ or 
► buttons to see the different pastel paper colors available. 

Stocks 
Hey, day traders, this one's for you. This gadget lets you build a stock portfolio and 
watch it rise and fall throughout the day. 

It contains your list of stocks, their current prices ( well, current as of 20 minutes ago), 
and the amount they've changed-green if they're up, red if they're down. Click a 
stock's name to see its chart and other details in a Web page. 

To set up your portfolio, proceed like this: 

• Add a stock by clicking the + button below the list, typing its name or stock ab­
breviation into the box at the top, and pressing Enter. If there's only one possible 
match-Microsoft, for example-the gadget adds it to the list instantly. If there's 
some question about what you typed, or several possible matches, you'll see a 
pop-up menu listing the alternatives, so you can click the one you want. 

Collapse the "Add a stock" dialog box by clicking the+ button again, or simply by 
clicking anywhere else on your screen. 

• Scroll the list by clicking the ... or " buttons. 

• Remove a stock from the list by clicking the little X button that appears when you 
point to its name. 

• See company names instead of abbreviations by clicking the Options (wrench) 
button and then turning on "Display company name in place of symbol." 

Tip: Ordinarily, the gadget displays the ups and downs of each stock as a dollar amount ("+.92" means up 
92 cents, for example). But if you turn on "Show change as a percentage"-which also appears when you 
click the Options button-you'll see these changes represented as percentages of their previous values. 

Pidure Puzzle 
For generations, Microsoft Windows fans had their Solitaire game-and only oc­
casionally looked over the backyard fence to see the Tile Game that their Macintosh 
friends were playing. The idea, of course, is to click the tiles of the puzzle, using logic to 
rearrange them back into the original sequence, so that they eventually slide together 
into the put-together photograph. 

• Change the photo by clicking the Options (wrench) button. 

• Pause the timer ( upper-left corner) by clicking the tiny clock. 

• See the finished photo, so you know what the goal is, by holding the cursor down 
on the little ? button. 
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. Give up by clicking the double-arrow button in the upper-right corner of the 
puzzle window. (The same button rescrambles the puzzle.) 

weather 
This gadget shows a handy current-conditions display for your city ( or any other 
city), and, at your option, even offers a three-day forecast. 

Before you get started, the most important step is to click the Options ( wrench) but­
ton. In the Options dialog box, you'll see where you can specify your city and state 
or Zip code. Type it in and press Enter; the gadget goes online to retrieve the latest 
Weather.com info. You can also specify whether you prefer degrees Celsius or degrees 
Fahrenheit. Click OK. 

Now the front of the gadget displays the name of your town, general conditions, and 
current temperature. 

• See more details by dragging the gadget out of the Sidebar. Now you see today's 
predicted high and low, the sky situation (like "Clear"), the current temperature, 
and the three-day forecast. 

• See the complete weather report by clicking the underlined location (such 
as "Central Park, NY") to open your Web browser and call up the full-blown 
Weather.com page for that location. 

Slide Show 
So you've got a digital camera and a hard drive crammed with JPEGs. What are you 
gonna do with 'em all? 

Slide Show offers an ingenious way to savor your handiwork all day long. It's just what 
it says: a small slideshow that presents one photo at a time for a few seconds each. Think 
of it as an electronic version of the little spouse 'n' kids photo that cubicle dwellers 
prop up on their desks-except that the picture changes every 15 seconds. 

The buttons in the tiny translucent control bar at the bottom of picture correspond 
to Previous Photo, Pause/Resume, Next Photo, and View (which opens up the pic­
ture-much larger now-in Windows Photo Gallery). 

• Substitute your own photos. When you first install Vista, this gadget presents 
Microsoft's favorite nature photos. But where's the fun in that? Once you're sick of 
them, click the Options (wrench) button. In the dialog box, use the Folder controls 
to choose a folder full of your own pictures. 

• Set up the show timing. Fifteen seconds is an awfully long time to stare at one 
photo, of course. Then again, if the pix change too often, they'll be distracting, and 
you won't get any work done. Nonetheless, the Options dialog box lets you keep 
each slide on the screen for as little as 5 seconds or as long as 5 minutes. 
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The Options box also lets you create a crossfade effect as one slide morphs into 
the next. And the Shuffle checkbox, of course, makes Slide Show present your pix 
in a random order, rather than their alphabetical order in the folder. 

Tip: If you drag this gadget off the Sidebar itself, you get to see your photos at a larger, more pleasant 
size. 

W.:::::::r ~o:::: :::~~-Are you sure you wantto ~ I 
install this gadget? 

Name: MyDictionafl/%201.3.0.0[lJ.gadget 

Publisher. Unknown Publisher 

1: 

j Install J I Don't Install j I.I' 

This file does not have a valid digital signature that verifies its 
publisher. You should only run software from publishers you 
trust. How can I decide what software to ru n? 
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Figure 6-12: 
Top: After downloading 
the new gadget (you'll 
have to click a couple 
of confirmation buttons 
along the way), you 
see this display. Click 
Install to install it ( or 
Don 'tlnstall, if you 
think it's evil). 

Bottom: Not all good 
things come from 
Microsoft. Here's a 
handful of neat gad­
gets written by other 
people. 



More Gadgets 
The gadgets that come with Vista are meant to be only examples-a starter collection. 
The real beauty of gadgets is that people can write their own new ones for the whole 
world to enjoy: gadgets that show your local movie listings, regional gas prices, your 
email Inbox, upcoming Outlook appointments, and so on (Figure 6-12, bottom). 

To see the current list of goodies that have been vetted by Microsoft, click "Get more 
gadgets online" in the Gadget Gallery described above. That takes you to the Mi­
crosoft Gadgets Gallery downloads page. (Alternatively, go straight to http://gallery. 
micro soft. com.) 

You should have no problem finding gadgets that tell you local traffic conditions, let 
you know if your flight will be on time, help you track FedEx packages, provide a 
word ( or joke, or comic strip) of the day, and so on. 

Installing a gadget 
Downloading and installing a gadget isn't hard, but there are a number of steps. Here's 
what you'll see if you use Internet Explorer, for example: 

• A warning that you're installing software not written by Microsoft ( click OK). 

• The File Download dialog box ( click Save). 

• The Save As dialog box, asking where to store the download (click Save). 

Unless you interfered, Internet Explorer drops the new gadget into your Personal~ 
Downloads folder. Open that folder, and then double-click the new gadget to install 
it. Figure 6-12 illustrates the process. 

Uninstalling a gadget 
If you decide you don't want a gadget, you can just close it (right-click it; from the 
shortcut menu, choose Close Gadget). That leaves it on your PC, but dormant. 

If, on the other hand, you really doubt you'll ever need it again, open your Gadget 
Gallery. Right-click the offending gadget; from the shortcut menu, choose Uninstall. 
Now it's really, truly gone. 

Filename Extensions and File Associations 
All Versions 

Every operating system needs a mechanism to associate documents with the applica­
tions that created them. When you double-click a Microsoft Word document icon, 
for example, Word launches and opens the document. 

In Windows, every document comes complete with a normally invisible filename 
extension ( or just file extension)-a period followed by a suffix that's usually three 
letters long. 
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= Forest Flowers 

Here are some common examples: 

When you double-click this icon ... 
Fishing trip.doc 

.. .this program opens it 
Microsoft Word 

Quarterly results.xis 
Home page.htm 
Agenda.wpd 
A home movie.avi 
Sudoku.gadget 
Animation.dir 

Microsoft Excel 
Internet Explorer 
Corel WordPerfect 
Windows Media Player 
Sidebar gadget 
Macromedia Director 

Tip: For an exhaustive list of every file extension on the planet, visit www.whatis.com; click the link for "Every 
File Format in the World." 

Behind the scenes, Windows maintains a massive table that lists every extension and 
the program that "owns" it. More on this in a moment. 

Displaying Filename Extensions 
It's possible to live a long and happy life without knowing much about these extensions. 
Because file extensions don't feel very user-friendly, Microsoft designed Windows to 
hide the suffixes on most icons (Figure 6-13). If you're new to Windows, you may 
never have even seen them. 

Some people appreciate the way Windows hides the extensions, because the screen 
becomes less cluttered and less technical-looking. Others make a good argument for 
the Windows 3.1 days, when every icon appeared with its suffix. 

Name 

.£_; Family Photos 

~Autumn Leaves.jpg I'--
~ Creek,jpg I'll' 

~ Desert Landscapejpg 

~Dockjpg 

~Forest.jpg 

~ Forest Flowersjpg 

Figure 6- IJ: 
As a rule, Windows shows filename extensions only on 
files whose extensions it doesn't recognize. The JPEG 
graphics at left, for example, don't show their suffixes. 
Right: You can ask Windows to display all extensions, 
all the time. 

Frangipani Flowers 
~Garden 

~ Frangipani Flowers.jpg 

~Gardenjpg 

~ Green Sea Turtle 

~ Humpback Whale 

~ Oryx Antelope 

~Toco Toucan 

i ~ lTree 

~Waterfall 

~Winter Leaves 

~ Green Sea Turtle.jpg 

~ Humpback Whalejpg 

~ Oryx Antelopejpg 

~Toco Toucanjpg 

~Treejpg 

~Waterfall.jpg 

~Winter Leavesjpg 
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1. Choose Start➔All Programs➔Accessories➔Sound Recorder. 

The window shown in Figure 7-12 appears. -----2. Click Start Recording. Make the sound, and then click Stop Recording as soon as 
possible thereafter. 

If you see the green a11imated bar dance in the Sound Recorder window, great; 
that's your VU (sound level) meter. It tells you that the PC is hearing you. If you 
don't ee this graphic, however, then the sound isn't getting through. Most likely, 
the problem is that your PC control panel isn't set to record the appropriate sound 
source. Visit the Control Panel and open the Sound panel to investigate. 

As soon as you click Stop Recording, the Save As box appears. 

Figure 1-12: 
Sound Recorder has been lobotomized since the 
Windows XP version, but it does the job. 

~ Sound Recorder 

■ .sti,p A«orcfm 

UPTO SPEED 

Text-Selection Fundamentals 
Before doing almost anything to text in a word processor, 
like making it bold, changing its typeface, or moving it to a 
new spot in your document, you have to highlight the text 
you want to affect. For millions of people, this entails drag­
ging the cursor extremely carefully, perfectly horizontally, 
across the desired text. And if they want to capture an 
entire paragraph or section, they click at the beginning, drag 
diagonally, and release the mouse button when they reach 
the end of the passage. 

That's all an enormous waste of time. Selecting text is the 
cornerstone of every editing operation in a word processor, so 
there are faster and more precise ways of going about it. 

For example, double-clicking a word highlights it, instantly 
and neatly. In fact, by keeping the mouse button pressed on 
the second click, you can now drag horizontally to highlight 
text in crisp one-word chunks-a great way to highlight text 
faster and more precisely. These tricks work anywhere you 
can type. 

In most programs, including Microsoft's, additional shortcuts 
await. For example, triple-clicking anywhere within a para­
graph highlights the entire paragraph. (Once again, if you 
keep the button pressed at the end of this maneuver, you 
can then drag to highlight your document in one-paragraph 
increments.) 

In many programs, including Word and WordPad, you can 
highlight exactly one sentence by clicking within it while 
pressing Ctrl. 

Finally, here's a universal trick that lets you highlight a large 
blob of text, even one that's too big to fit on the current 
screen. Start by clicking to position the insertion point cursor 
at the very beginning of the text you want to capture. Now 
scroll, if necessary, so the ending point of the passage is vis­
ible. Shift-click there. Windows instantly highlights everything 
that was in between your click and your Shift-click. 
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this command. It opens a fresh, virginal copy of Internet fa,l)lorer, with all of your 
add-on junk stripped away-a copy that, in theory, should perform as smoothly as 
the day it was born. 

Tablet PC 
These links take you to three programs that are especially (or exclusively) use­
ful to people who use PCs with touch screens-Tablet PCs, as they're known. All 
three-Sticky Notes, Tablet PC Input Panel, and Windows Journal- are described 
in Chapter 19. 

Extras and Upgrades 
All Versions 

This little grab bag offers a few links to Microsoft-run online stores and storehouses 
of information: 

• Windows Anytime Upgrade. As you're probably aware, Windows Vista comes in 
a number of different editions: Home Premium, Business, Enterprise, and so on. 
(Details are in the Introduction.) 

But what if you buy, say, the Home Basic version, but you later decide that you 
really wanted the cool looks and video-editing features of Home Premium? Or 
maybe you bought Business, but you really crave the backup and encryption 
features of Ultimate? 

Not to worry; Microsoft has made sure that you'll be taken care of. Using this 
command, you can upgrade your version of Vista to a higher version; all you need 
is a valid credit-card number and a few bucks in your account. 

When you choose this command, you go online to the Windows Anytime Upgrade 
Web page. This site detects which Vista version you have now, and offers to show 
you what kind of happiness awaits when you upgrade to one of the higher-priced 
versions. 

If you decide to move ahead with the upgrade, you're asked to find your original 
Windows Vista installation DVD. (Little did you know that it actually includes all 
versions of Vista-but holds back certain features that you haven't paid for.) 

The upgrade process doesn't disturb any of your programs, settings, or documents. 
Everything remains exactly where it was (although Microsoft does recommend 
that you make a backup before upgrading, just in case). 

• Windows Marketplace is Microsoft's online catalog. It's always there when your 
credit card is feeling under-exercised. ( One useful link here: Windows Tested Prod­
ucts. It's a list of programs that Microsoft has certified to be Vista-compatible.) 

• Windows Ultimate Extras appears only if you're using the Ultimate edition of 
Windows Vista. One of the perks of Ultimate ownership is, of course, all the bonus 
goodies that Microsoft intends to offer just for you-and the Ultimate Extras Web 
site is where you'll find 'em. 
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When you turn on Snap To, every time a dialog box appears, your mouse pointer 
jumps automatically to the default button, so that all you need to do is dick. 
(And to click a different button, such as Cancel, you have to move the mouse only 
slightly to reach it.) 

• Ofaplay pointer trails. Pointer trails are ghost images of your mouse pointer that 
trail behind the pointer like ducklings following their mother. In general, this 
stuttering-cursor effect is irritating. 

• Hide pointer while typing. Hiding the mouse pointer while you're typing is useful 
if you find that it sometimes gets in the way of the words on your screen. As soon 
as you use the keyboard, the pointer disappears; just move the mouse to make the 
pointer reappear. 

• Show location of pointer when I press the CTRL key. If you've managed to lose the 
cursor on an LCD projector or a laptop with an inferior screen, this feature helps 
you gain your bearings. When you press and release the Ctrl key after turning on 
this checkbox, Windows displays an animated concentric ring each subsequent 
time you press the Ctrl key to pinpoint the cursor's location. 

Whee/tab 
The scroll wheel on the top of your mouse may be the greatest mouse enhancement 
since they got rid of the dust-collecting ball on the bottom. It lets you zoom through 
Web pages, email lists, and documents with a twitch of your index.finger. 

Use these controls to specify just how much each wheel notch scrolls. (You may not 
see this tab at all if your mouse doesn't have a wheel.) 

Hardware tab 
The Mouse program provides this tab exclusively for its Properties buttons, which 
takes you to the Device Manager's device properties dialog box. Useful if you have to 
troubleshoot a bad driver. 

Network and Sharing Center 
This nel:\vork command center is an important step forward in Vista. It offers, among 
other things, a handy map that shows exactly how your PC is connected to the Inter­
net. It also contains a tidy list of all networking-related features (file sharing, printer 
sharing, and so on), complete with on/off switches. See Chapter 26 for details. 

Offline Files 
The Offline Files applet opens into a dialog box where you can manage your offline 
file folders and access the Sync Center. See Chapter 19. 

Parental Controls 
This applet lets you, the wise parent, control what your inexperienced or out-of-control 
loved one (usually a child, but sometimes a spouse) can and cannot do on (or with) 
the computer. For more information, see Chapter 10. 
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system 
This advanced control panel window is the same one that appears when you right­
dick your Computer icon and choose Properties from the shortcut menu ( or press 
::+Break key). It's been revamped for Windows Vista, but still contains the various 
settings that identify every shred of circuitry and equipment inside, or attached to, 

your PC. 

When you open the System icon in Control Panel, you're taken to the System window 
(Figure 8-16). Here you can find out: 

Figure B· 16: 
The System window 
is a one-stop shop 
for all things com­
puter-related. From 
your hardware (and 
what Vista thinks of 
it) to your product 
ID key, System's got 
you covered. 

View basic information about your computer 

Windows edition 

\\1"1ndDM Y'rst1"" Ultlm.tt.t 

Copyright Q 2006 Microsoft Corporation, All rights reseM?:d, 

Rating: ~ Windows Experi ence Ind~ 

Processor. 

Memo,y (RAM): 

Genuine lntel(R) CPU T2500 @ 2.00GHz 2.00 GHz 

992MB 

System type: 32-bit Operating System 

Computer nam~ domain, and work.group settings - - -- - --

Computtr name: 

Full computer name:: 

Computer d~cription: 

Workgroup: 

CoreOuolaptop 

CoreDuolaptop 

WORKGROUP 

f,Change settings 

Wind~•ctlvllion-----------------­

ft, 'i\ 1 day(s) until automatic activation , ActTVate Windows now 

Product IO: 89580-314-2251236-71844 ~Change prnduct key 

• What edition of Vista is installed on your computer. As you know, Vista comes 
in several editions. Not all editions are made equal; if you're flailing to find some 
feature that you could have sworn is supposed to be in Vista, it's good to check here. 
You might find out that the feature you want is available only on higher-priced 
versions. 

• Your PC's performance rating. See page 20. 

• The model name and speed of your PC's processor chip (such as Pentium 4, 2.6 
GHz). 

• How much memory your PC has. That's a very helpful number to know, particu­
larly if you need to improve your computer's speed. 
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Tablet PC Settings 
This applet is all about managing a Tablet PC, one of those touchscreen laptop 
thingies. Here, you'll find settings that focus on tablet display orientation and calibra­
tion, handwriting recognition, and configuring pen input. If you don't have a Tablet 
pc, this dialog box is not for you. Otherwise, flip to Chapter 19. 

Taskbar and Start Menu 
This program controls every conceivable behavior of the taskbar and Start menu. You 
can read all about these options-the same ones that appear when you right-dick 
the taskbar or the Start button and choose Properties from the shortcut menu-in 
Chapters 1 and 2. 

Text to Speech 
Text to Speech opens the Speech Properties dialog box. (You can also get here from 
the Speech Recognition applet.) 

Here's where you configure the voice of Windows-the robotic voice, called Microsoft 
Anna-that you hear any time Windows reads text aloud. 

The catch, of course, is that Windows never does read text aloud, except when you're 
using Narrator (page 269)-and Narrator has its own set of voice-selection controls. 
Microsoft Word can read text to you, however, and for that reason, you may be happy 
to know that you can specify Anna's rate of speaking ( or that of the other Vista voice 
options) using this dialog box. 

User Accounts 
This control panel is the master switch and control center for the user-accounts 
feature described in Chapter 23. If you're the only one who uses your PC, you can 
(and should) ignore it. 

Welcome Center 
The Welcome Center, a new Vista feature, is the window that welcomes you every 
single time you log in (until you turn off the "Run at startup" checkbox). This win­
dow conveniently displays how to get started with Vista and pay Microsoft for more 
products and services. For a more detailed look at this window and its offerings, see 
Chapter 1. 

(Why is this even in the Control Panel? Well, let's not be nit-picky.) 

Windows CardSpace 
Ever have to fill out a form on the Internet-name, address, email address----only to 
go to a different site that requests exactly the same information? 

Of course you have. Everyone has, and it's annoying as heck. 

CardSpace is Microsoft's attempt to solve that duplication-of-effort problem. You're 
supposed to create a profile containing this kind of information, like a digital ID 
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Internet Explorer 7 

Microsoft has gon. e to great lengths to integrate the Internet into every n.ook 
and cranny of Windows. Links and buttons that take you on.line are every­
where: on the Help screens, in the Windows freebie programs, and even in 

the "Send error report to Microsoft?" dialog boxes that appear after a program crashes. 
Once you've got your Internet connection working (Chapter 9), you may find that 
it's easier to go online than it is not to. 

Internet Explorer ( or IE, as it's often abbreviated) is the most famous Web browser 
on earth, thanks to several years of Justice-department scrutiny and newspaper 
headlines. 

The greatly revamped version 7 offers boatloads of new features. A huge number of 
them are related to security, since most bugs and viruses enter your PC from the In­
ternet: the new phishing filter, pop-up blocker, download blocker, Windows Defender, 
cookies manager, ActiveX blocking, Protected Mode, parental controls, and so on. 

There's so much of this stuff, in fact, that they'd weigh this chapter down with all their 
negative energy. They've been offloaded to Chapter 10. 

There are lots of great new productivity features, too, though: an RSS reader, tabbed 
browsing, a new Search bar, a new interface design, and so on. This chapter is all about 
using Internet Explorer to surf the Web. 

(Hey, it could happen.) 

CHAPTER 11: INTERNET EXPLORER 7 

CHAPTER 

11 

367 



IE7: The Grand Tour IE7: The Grand Tour 

368 

All Versions 

You can open Internet Explorer in a number of ways: 

• Choose its name from the Start menu. 

• Click its shortcut on the Quick Launch toolbar. 

• Type a Web address-its URL (Uniform Resource Locator)-into a window's 
Address bar. A Web page URL usually begins with the prefix http://, but you can 
leave that part off when typing into the Address bar. 

• Click a blue, underlined link on a Windows Help screen . 

... and so on. 

As you can see in Figure 11-1, the Internet Explorer window is filled with tools that 
are designed to facilitate a smooth trip around the World Wide Web. 

Back, Forward Address bar Refresh Stop Search bar Figure II-I: 

· ot Ooug Thoma,, Rob Md)onald_ 

Edlton,Piwlb,l1de1mbJln~837 

amazon.conr 

5e.arch Amazon.com @) Reid Gffu .41,) Wtll Sea 1th a 

The Internet 
Explorer window 
offers tools and 
features that let 
you navigate the 
Web almost effort­
lessly; these various 
too/bars and status 
indicators are 
described in this 
chapter. Chief 
among them: the 
Address bar, which 
displays the 
address (URL) 

~ i, 

Amazon.com Editors' Picks 
URow r.1 Alt ( ll I lCH\ ., 
l'.IIC:KS 

-~ -~ 
• Art Lifestyle & 
QQl!i.till -~ 
8 st nooks- ol the Ytor 

Explore 
· our~ ,,. ~ 

~~nd 
~ 

cos tomec [iyoc1t.P-S in 
n ut: Dor t af , Ms 

There 1s noth ing we Amazon.com editors enjoy more than 
' recommending new productg to our friends . We'11e : 
' establlshed our Editof!' Picks program to give you our f 
l he.artfelt opinions of cur fa11orite It.ems, b@ they new, ci ld, or 

I as ye t unreleased. The•e are the boc"5, music, movies, and 
other products we truly love and want olhers 10 enjoy, too . 

I A love Sto ry •.• with Teeth 

Editors' Picks In 
Se.e w 
na.w, t 
ju;tp; 
weird 
month 
select 

E-dttor,' P{(;ks in I 

StephEn King follows up his subllmely gory ~--
2omblo lhrllle.r f;d with, of ail thing•, a love j A Fothar nnd so, 
ttory, Thls is .ftiD king afti!'r all, so LlsCY'f stqry Saldnu story 
s terrifyln9 and you'll stin want to sleep \•1ith • Oylan 
the Ught! on, but It's a love s tory at heart. Schaff, 
NPti Robert, c.alls it a 'dark a:od dH perate· his gre( 

•, s tory about a m~rri.age and a widow1s gri~f. fathe.r, 
That's true., but ,t•• only a part of the whofe decide 

story. I think King ii also writing abou t ij writer's- lave- for enroll ir 
the &tor1-:;; fo r ~ e Slductive, dangerous journey that week-long bread,.. 

Internet I Protected Mode:: On 

of the Web page 
you're currently 
seeing, and the 
standard buttons, 
which let you con­
trol the Web-page 
loading process. 

A link ( or hyperlink) is a bit of text, or a little graphic, that's been programmed to 
serve as a button. When you click a link, you're transported from one Web page to 
another. One may be the home page of General Motors; another might have baby 
pictures posted by a parent in Omaha. About a billion pages await your visit. 
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Tip: Text links aren't always blue and underlined. In fact, modem Web designecs sometimes make it very 
difficult to tell which text is clickable, and which is just text. When in doubt, move your cursor over some 
text. If the arrow changes to a pointing-finger cursor, you've found yourself a link. 

IE7: The Grand Tour 

Actually, you can choose to hide all underlines, a trick that makes Web pages look cleaner and more attractive. 
underlines appear only when you point to a link (and wait a moment). If that arrangement appeals to you, 
open Internet Explorer. Choose Tools➔lnternet Options, click the Advanced tab, scroll down to "Underline 
links," select the Hover option, then click OK. 

Menus and Gizmos 
Internet Explorer 7 no longer has a traditional menu bar (although you can make 
the old one come back if you press Alt or FlO). Instead, it offers five tiny menu icons 
at the upper-right corner. Each little • is, in fact, a menu. 

Here's a look at the other basic controls-the doodads that surround your browser 
window. 

The Address Bar 
When you type a new Web page address (URL) into this strip and press Enter, the 
corresponding Web site appears. (If only an error message results, then you may 
have mistyped the address, or the Web page may have been moved or dismantled-a 
relatively frequent occurrence.) 

Because typing out Internet addresses is so central to the Internet experience and such 
a typo-prone hassle, the Address bar is rich with features that minimize keystrokes. 
For example: 

• You don't have to click in the Address bar before typing; just press Alt+ D. 

GEM IN THE ROUGH 

Let Autofill Do the Typing 
Internet Explorer can remember the user names and pass­ When you want IE to "forget" your passwords-for security 
words you type into those 
"please sign in" Web sites. 

You can't miss this feature; 
each time you type a password 
into a Web page, this dialog 
box appears. 

It's a great time- and brain­
saver, even though it doesn't 
work on all Web sites. (Of 

reasons, for example-choose 
_. Tools➔Options . Click the ~ ~'--- - - --==-- - ~-;,..._- - ~ Ali~pl•te P._ords 

Do you Wirt hlemet E,ipl....,,-to .-1111, 
p.,sswonl? 

Internet Explwca,n,m....,erthispassword so you don\ 
have lo type 'I egai'J the ne,,d. time you visA this p!!ige 

IE! Dool off,. to remerrber any more pasowads 

leMJ abN NoConp',;le 

Content tab, click Settings, and 
click OK. 

Here in this dialog box, you'll 
also find checkboxes that 
control what Internet Explorer 
memorizes: Web addresses 
(autocomplete in the Address 

course, use it with caution if you share an account on your 
PC with other people.) 

bar), forms (your name, address, and so on), and user 
names and passwords. 
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• You don't have to type out the whole Internet address. You can omit the http://www 
and .com portions if you press Ctrl+Enter after typing the name; Internet Explorer 
fills in those standard address bits for you. 

To visit Amazon.com, for example, a speed freak might press Alt+D to highlight 
the Address bar, type amazon, and then press Ctrl+Enter. 

• Even without the Ctrl+ Enter trick, you can still omit the http:// from any Web ad­
dress. (Most of the time, you can omit the www., too.) To jump to today's Dilbert 
cartoon, type dilbert.com and then press Enter. 

• When you begin to type into the Address bar, the AutoComplete feature compares 
what you're typing against a list of Web sites you've recently visited. IE displays a 
drop-down list of Web addresses that seem to match what you're typing. To spare 
yourself the tedium of typing out the whole thing, just click the correct complete 
address with your mouse, or use the down arrow key to reach the desired listing 
and then press Enter. The complete address you selected then pops into the Ad­
dress bar. 

(To make AutoComplete forget the Web sites you've visited recently-so that 
nobody will see what you've been up to-delete your History list, as described 
on page 352.) 

• Press F4 ( or click the T inside the right end of the Address bar) to view a list of 
URLs you've visited recently-your History list, in other words. Once again, you 
can click the one you want-or press the up or down arrow keys to highlight one, 
and the Enter key to select it. 

Topside Doodads 
Around the Address bar, you'll find several important buttons. Some of them lack 
text labels, but all offer too/tip labels: 

• Back button, Forward button. Click the Back button to revisit the page you were 
just on. (Keyboard shortcut: Backspace and Shift+Backspace, or Alt+left arrow and 
Alt+right arrow.) 

Tip: Pressing Shift as you turn your mouse's scroll wheel up or down also navigates forward and back. 
Coo l. 

Once you've clicked Back, you can then click the Forward button ( or press Alt+right 
arrow) to return to the page you were on before you clicked the Back button. Click 
the T button for a drop-down list of all the Web pages you've visited during this 
online session (that is, within this browser window, as opposed to your long-term 
History list). 

• Refresh button. Click this double-arrow button (just to the right of the Address 
bar) if a page doesn't look or work quite right, or if you want to see the updated 
version of a Web page ( such as a stock ticker) that changes constantly. This button 
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forces Internet Explorer to redownload the Web page and reinterpret its text and 

graphics . 

• Stop (X) button. Click this button, at the far right end of the Address bar, to 
interrupt the downloading of a Web page you've just requested (by mistake, for 
example). (Keyboard shortcut: Esc.) 

• Search bar. There's no tidy card catalog of every Web page. Because Web pages ap­
pear and disappear hourly by the hundreds of thousands, such an exercise would 
be futile. 

The best you can do is to use a search engine, a Web site that searches other Web 
sites. You might have heard of the little engine called Google, for example. 

But why waste your time plugging in www.google.com? Here's one of Internet 
Explorer's most profoundly useful features-a Search box that accesses Google 
automatically-or any other search page you like. Type something you're looking 
for into this box-electric drapes, say-and then press Enter. You go straight to 
the Google results page. 

Actually, the factory setting is Microsoft's own search page, Live.com, not Google. 
It takes a moment to reprogram the Search box so that it uses Google or another 
search service, but it's worth the effort. From the Y button to the right of the magni­
fying glass icon, choose Find More Providers. See Figure 11-2 for the next steps. 

Tip: Truth is, it's often faster to type your search phrase into the Address bar itself, if for no other reason 
than you have a keyboard shortcut to get your cursor in there (Alt+D). When you press Enter, IE does a Web 
search for that term, using the same search service you've set up for the Search box. 

Window Controls 
These last items wrap up your grand tour of Internet Explorer's window gizmos: 

• Scroll bars. Use the scroll bar, or the scroll wheel on your mouse, to move up and 
down the page-or to save mousing, press the Space bar each time you want to 
see more. Press Shift+Space bar to scroll up. (The Space bar has its traditional, 
space-making function only when the insertion point is blinking in a text box or 
the Address bar.) 

You can also press your up and down arrow keys to scroll. Page Up and Page Down 
scroll in full-screen increments, while Home and End whisk you to the top or bot­
tom of the current Web page. 

• Home button. Click to bring up the Web page you've designated as your home 
page-your starter page. 

And which page is that? Whichever one you designate. Open a good startup page 
( Google, NYTimes.com, Dilbert.com, whatever), and then choose Add or Change 
Home Page from this icon's pop-up menu. 
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IE7: The Grand Tour • Status bar. The status bar at the bottom of the window tells you what Internet 
Explorer is doing (such as "Opening page ... " or"Done"). When you point to a link 
without clicking, the status bar also tells you which URL will open if you click it. 
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Figure 11-2: 
Top: To add 
search services 
to this pop-up 
menu, start by 
choosing Find 
More Providers. 

Middle: This 
page lists lots of 
popular search 
services, including 
Google, Yahoo, 
Ask.com, and 
more specialized 
pages: Amazon 
far books, ESPN 
for sports, and so 
on. You can even 
add new ones 
using the Create 
Your Own section. 

Bottom: When 
you click a search 
service's name, 
you're asked to 
confirm-and 
you're given the 
chance to make 
it your default 
search, the one 
that IE always 
uses. Click Add 
Provider. 

And when you're opening a new page, a graph appears here, showing that your PC 
is still downloading (receiving) the information and graphics on the Web page. In 
other words, you're not seeing everything yet. 

If you consult all this information only rarely, you may prefer to hide this bar, 
thus increasing the amount of space actually devoted to showing you Web pages. 
To do so, choose View-fStatus Bar from the Classic menu bar (press Alt). The 
checkmark disappears from the bar's name in the View menu to indicate that the 
status bar is hidden. 
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Tabbed Browsing 
All Versions 

Beloved by hard-core surfers the world over, tabbed browsing is a way to keep a bunch 
of Web pages open simultaneously-in a single, neat window, without cluttering up 
}'our taskbar with a miUion buttons. 

figure 11-3 illustrates. 

Figure 11-1: 
When you 

6 Wekom~ to To,bbed Brow\tng - Wrndo,.,.s lnter<">et Explorer 

Ctr!+ Shift-click 
a link, or type 
an address and 
press Alt+Enter 
or a?,-Enter, you 
open a new 
tab, not a new 
window as you 
ordinarily would. 
You can now 
pop from one 
open page to an­
other by clicking 
the tabs above 
the window, or 
close one by 
clicking its X but­
ton ( or pressing 
Ctr!+W). 

Shortcut-0-Rama 

1 fil abolit::Trabi 

ork Time - BrE:aV.ng NtwS,. 1.iVofld Mr:w-; & t 

You've opened a ne 
"'l'limt,:<o,,y' 

'Nith tabs you can: 

• Use one Internet Explorer window to view all your webpi:iges.. 
• Open links in a background tab w·hile vrewing the page you're on. 
• Save c1nd open multiple webpages at once by u5ing favorites and home page- tabs, 

To get sta rted: 

• Press the CTRL key while clicking links (or use ; he middle mouse button). 

• Click any tab with the midd le mou$e button to dose it. 
• Press ALT +ENTER from the add1 ess bar or searcl1 box to open the result in a ne•u tab, 

1@ Lea,rn more about tabs 

0 Show rnore talJ shortcL1ts 

EJ Don't show this page again 

~ nteme.t I Protected Mode: On 

Turning on tabbed browsing unlocks a whole raft oflnternet Explorer shortcuts and 
tricks, which are just the sort of thing power surfers gulp down like Gatorade: 

• To open a new, empty tab in front of all others, press Ctrl+ T (for tab), or click the 
New Tab stub identified in Figure 11-3, or double-click anywhere in the empty 
area of the tab row. From the empty tab that appears, you can navigate to any site 
you want. 

• To open a link into a new tab, Ctrl-click it. Or click it with your mouse wheel. 

Or, if you're especially slow, right-click it and, from the shortcut menu, choose 
Open in New Tab. 
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Nate: Ctrl-clicking a link opens that page in a tab behind the one you're reading. That's a fantastic trick when 
you're reading a Web page and see a reference you want to set aside for reading next, but you don't want 
to interrupt whatever you're reading. 

But if you want the new tab to appear in front, add the Shift key. 

• To close a tab, either click the X on it, press Ctrl+ W, press Alt+ F4, or click the tab 
with your mouse wheel or middle mouse button, if you have one. 

Tip: If you press Ctrl+Alt+4, you close all tabs except the one that's in front. 

• Switch from one tab to the next by pressing Ctrl+ Tab. Add the Shift key to move 
backwards through them. 

• Jump to a specific tab by pressing its number along with the Ctrl key. For example, 
Ctrl+3 brings the third tab forward. 

• Save a tab configuration. If there's a certain set of Web sites you like to visit daily, 
open them all into tabs. Then click the Add to Favorites button; from its menu, 
choose Add Tab Group to Favorites. Type a name for the group, and then click 
Add. 

Later, you can recreate your current setup-with all of them in a tabbed window­
by selecting the resulting listing in the Favorites menu and then clicking the blue 
right-arrow button beside its name. The beauty of this arrangement is that you 
can start reading the first Web page while all of the others load into their own tabs 
in the background. 

One more note to tab fans: When you close Internet Explorer, a dialog box appears 
asking if you really want to close all the tabs. If you click Show Options at this point, 
you're offered an opportunity to "Open these the next time I use Internet Explorer." 
Turn that on and click Close Tabs; the next time you go a-browsing, you'll pick up 
right from the tabs where you left off. 

Note: If you find all this tabby business confusing and unnecessary, you can turn off the whole feature. In 
Internet Explorer, choose Tools➔lnternet Options. Click the General tab; under Tabs, click Settings. Turn off 
Enable Tabbed Browsing, and then click OK twice. 

Quick Tabs (Thumbnails) 
Once you've got a bunch of tabs open, you may face a horizontal screen-space crunch. 
How much, exactly, of the text "Welcome to Bass World-The Internet's Global 
Resource for Bass Fisherfolk" can you see on a half-inch tab? 

Not much. But how, then, are you supposed to tell your tabs apart? 

By using another new Internet Explorer feature called Quick Tabs. Figure 11-4 shows 
all. 

WINDOWS VISTA: THE MISSING MANUAL 



Tip: You can close a tab directly from the Quick Tabs screen, too-just click the X button in the upper-right 
corner of the thumbnail. 

Tab Settings 
People get really, really obsessive over tabs for some reason. They want tabs to behave 
just the way they expect, or it's back to Firefox they go. 

Figure 11-4: 
Quick Tabs shows 
you thumbnails of 
all the Web pages 
you've opened into 
tabs, making it 
simple to tell them 
apart. One click on a 
thumbnail returns it 
to full size, with that 
tab in front of the 
others. All you have 
to learn is the Quick 
Tabs keystroke, 
which is Ctr/+Q-or 
the location of the 
Quick Tabs button, 
shown here. (Repeat 
the trigger to exit 
the Quick Tabs view 
without changing 
anything.) 

Quick Tabs tab 

bass fishing - Googl... X 

~ 
~ 

No worries-Internet Explorer lets you customize tabs' behavior to within an inch of 
their lives. Start by choosing Tools➔Internet Options➔General; in the Tabs section 
of the dialog box, click Settings. Here's the most useful of what you'll find: 

• Enable Tabbed Browsing. This is the on/off switch for the whole tab feature. 

• Warn me when closing multiple tabs. If tabs are open when you close Internet 
Explorer, a confirmation box appears: "Do you want to close all tabs?" It's semi­
annoying but semi-useful, because you may not realize that you're about to close 
all your tabs. 

You can turn on "Do not show me this dialog again" right in that box, or you can 
turn off this checkbox. 

• Always switch to new tabs when they are created. Makes every new tab appear 
in front of the others, even if you Ctrl-click a link rather than Ctrl+Shift-click it. 
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(Even if you leave this option off, though, Ctrl+Shift-clicking a link still opens 
the tab in front.) 

• Enable Quick Tabs. This is the on/ off switch for the feature shown in Figure 11-4. 

• Open new tabs next to the current tab. Ordinarily, IE creates a new tab right next 
to the one you're on, thus shoving all the other tabs off to the right. If you turn 
off this checkbox, new tabs appear to the right of all open tabs. 

• Load only the first home page when Internet Explorer starts. Got a tab group set 
as your home page (page 384)? Turn on this box if you want only the first tab to 
open when IE starts, rather than the whole tab group. 

• Open home page for new tabs instead of a blank page. When you click the New 
Tab tab, a blank page normally opens. If you instead want the new tab to appear 
with your home page on it, turn on this box. 

• When a pop-up is encountered. When a "good" pop-up window opens, should it 
open in a new window or a new tab? Or should Internet Explorer try to figure out 
which would be most helpful? (If the Web programmer has specified a specific size 
for the pop-up, it appears in a window; otherwise, in a new tab.) 

• Open links from other programs in .... If you click a link in an email message, 
should the resulting Web page open in a new window or a new tab? Or should 
it replace whatever's currently in the frontmost window or tab? Only you can 
decide. 

Actually, there's one more useful tabbed-browsing setting that's not here-for some 
reason, Microsoft stuck it on the Tools➔Internet Options➔Advanced tab. It's "Use 
most recent order when switching tabs with Ctrl+ Tab." 

Ordinarily, pressing Ctrl+ Tab moves you through your tabs from left to right; adding 
Shift moves you backward. 

But if you turn this option on, Ctrl+ Tab jumps through the tabs you've visited in 
reverse chronological order. It's just the way Alt+ Tab works when you're switching 
between Windows programs. This arrangement makes it very easy to compare two 
Web pages, because pressing Ctrl+ Tab bounces you back and forth between the last 
two you've visited. 

Note: This option also affects what happens when you hit Ctrl+W repeatedly to close tabs. They close in 
reverse chronological order. 

Favorites (Bookmarks) 
All Versions 

When you find a Web page you might like to visit again, press Ctrl+D. That's the 
keyboard shortcut for the Add to Favorites command. (The long way is to click the 
Add to Favorites button identified in Figure 11-5.) Type a shorter or more memorable 
name, if you like, and click Add. 
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The Web page's name appears instantly in the "Favorites center," which is the menu 
indicated by the yellow star (Figure 11-5). The next time you want to visit that page, 
open this menu-or press Alt+C-and click the Web site's name in the list. 

Tip: You can send your list of Favorites to or from other browsers or other PCs, which can save you a lot 

of time. 

To do that, open the Add to Favorites menu (Figure 11-5); choose Import and Export. The Import/Export 
wizard appears to guide you through the process. Consider saving them onto, for example, a flash drive, for 
ease in transporting to another location or computer. 

Figure 11-s: 
Top: When you want to flag a Web 
page for visiting later, using this menu 
is one way to do it. 

Bottom: Internet Explorer offers to add 
this Web page's name (or a shorter 
name that you specify for it) either 
to the Favorites menu itself, or to a 
"folder" (category) within that menu. 
The next time you want to visit that 
page, just select its name from the 
star-shaped menu at the top left of the 
window. 
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You can rearrange the commands in your Favorites menu easily enough. Open the Fa­
vorites center (Figure 11-6), and then drag the bookmarks up and down in the list. 

Or, for more elaborate organizing tasks-creating and deleting folders, renaming sites, 
and so on-click the Add to Favorites button (Figure 11-5) and, from the shortcut 
menu, choose Organize Favorites. You get a little dialog box that makes all of those 
tasks easy. 
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Tip: If you Shift-click the Organize Favorites command, you open a standard Explorer window that lists your 
favorites as though they're standard computer files (which they are). Technically, you're now inside your 
Personal➔Favorites folder. Now you can use standard Windows techniques to delete, rename, copy, paste, and 
otherwise manipulate your Favorites. You can even back them up, copy them to a flash drive, and so on. 
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Figure 11-6: 
When the Favorites 
menu opens, you can 
drag names up or down 
to rearrange the list, as 
shown. Or right-click one 
to access the commands 
that rename, delete, 
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or file a favorite into a 
folder. (Unfortunately, 
the Favorites menu cov­
ers up port of the Web 
page you're reading. It 
hides itself soon enough, 
but you might also want 
to freeze the Favorites 
Center open so that it 
doesn't cover the page. 
To do that, click the Pin 
the Favorites Center 
button shown here.) 
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The Links Toolbar 
The Favorites pane is one way to maintain a list of Web sites you visit frequently. But 
opening a Web page in that pane requires two mouse clicks- an exorbitant expenditure 
of energy. The Links toolbar, on the other hand, lets you summon a few, very select, 
very favori te Web pages with only one click. 

You make the Links toolbar appear by choosing Tools~Toolbars~Links. Figure 11-7 
illustrates how to add buttons to, and remove them fro m, this toolbar. Once they're 
there, you can rearrange these buttons simply by dragging them horizontally. 

Tip: As shown in Figure 11-7, you can drag a link from a Web page onto your Links tool bar. But you can also 
drag it directly to the desktop, where it turns into a special Internet shortcut icon. To launch your browser 
and visit the associated Web page, just double-click this icon whenever you like. 

Better yet, stash a few of these icons in your Start menu or Quick Launch toolbar for even easier access. 
(Moreover, if you open your Computer ➔C: drive➔Users➔ [Your Name]➔Favorites folder, you'll see these 
shortcut icons for oil your favorite links. Feel free to drag them to the desktop, Quick Launch tool bar, Links 
toolbar, or wherever you like.) 
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History List History List 

All Versions 

This history is a list of the Web sites you've visited. It's the heart of three IE features: 
AutoComplete, described at the beginning of this chapter; the drop-down list at the 
right side of the Address bar; and the History list itself. 

Figure 11-7: 
Once you've got a 
juicy Web page on 

~ You Tube- Broadcast Yourself. - Windows Internet Explorer 
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the screen, you can 
turn it into a Link by 
dragging the tiny page 
icon directly to the 
Links bar, as shown 
here. (You can also 
drag any link from a 
Web page onto the 
too/bar.) If you right­
click a link, you can 
choose Rename (to 
pick a shorter name 
that fits better). 

My Account MvVideos My Favorites I My Friends I My lnbox I 

Figure 11-B: 
If you click the little " button next to the word 
History, you'll see that you can view the list sorted 
by Web site, date, frequency of visits-or you can 
see only the sites you've visited today, in order. The 
same little pop-up menu offers a command called 
Search History, so that you can search for text in the 
History list-not the actual text on those pages, but 
text within the page addresses and descriptions. 
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That's the pane that appears when you click the Favorites (star) button and then 
click History-or just press Ctrl+H. Figure 11-8 presents the world's shortest 
History class. 

The History pane lists the Web sites you've visited in the last week or so, neatly or­
ganized into sub folders like "Today" and "Last Week." These are great features if you 
can't recall the URL for a Web site that you remember having visited recently. 

Click one of the time-period icons to see the Web sites you visited during that era. 
Click the name of a Web site to view a list of each visited page within that site-and 
click an actual URL to reopen that Web page in the main window. 

You can configure the number of days for which you want your Web visits tracked. 
To do so, choose Tools➔ Internet Options➔General; where it says "Browsing history," 
click Settings. At the bottom of the dialog box, you'll see the "Days to keep pages in 
history" control. 

For details on erasing your History list for security purposes, see page 352. 

Tip: The more days IE tracks, the easier it is for you to refer to those addresses quickly. On the other hand, 
the more days you keep, the longer the list becomes, which may make it harder to use the list easily and 
efficiently. 

Oh, and if you set "Days to keep pages in history" to 0, Internet Explorer won't track your movements at all. 
(You know who you are.) 

RSS: The Missing Manual 
All Versions 

In the beginning, the Internet was an informational Garden of Eden. There were 
no banner ads, pop-ups, flashy animations, or spam messages. People thought the 
Internet was just the greatest. 

Those days, unfortunately, are long gone. Web browsing now entails a constant battle 
against intrusive advertising and annoying animations. And with the proliferation of 
Web sites and biogs, just reading your favorite sites can become a full-time job. 

Enter RSS, a technology that lets you subscribe to feeds-summary blurbs provided 
by thousands of sources around the world, from Reuters to Microsoft to your nerdy 
next-door neighbor. News and blog sites usually publish RSS feeds, but RSS can also 
bring you podcasts (recorded audio broadcasts), photos, and even videos. 

You used to need a special RSS reader program to tune into them-but no longer. 
Internet Explorer 7 can "subscribe" to updates from such feeds, so you can read any 
new articles or postings at your leisure. 
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The result? You spare yourself the tedium of checking for updates manually, plus you 
get to read short summaries of new articles without ads and blinking animations. 
And if you want to read a full article, you can click its link in the RSS feed to jump 
straight to the main Web site. 

Note: RSS either stands for Rich Site Summary or Really Simple Syndication. Each abbreviation explains 
one aspect of RSS- either its summarizing talent or its simplicity. (Web feeds and XM L feeds are the same 
thing.) 

Viewing an RSS Feed 
So how do you sign up for these free, automatic RSS "broadcasts"? Watch your tab 
bar as you're surfing the Web. When Internet Explorer's Feeds button (Figure 11-9) 
turns orange, IE is telling you, "This site has an RSS feed available." 

Figure 11-9: 
Top: When the Feeds 
button changes color, 
you've got yourself 
a live one: a Web 

6 Gizmodc The G11dgt'. Guide,• Wir-dows l<1ter0~t Explore r 

RSS: The Missing 
Manual 
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Middle: Now you get 
a sneak peek at what 
the feed looks like. If 
you like, subscribe, as 
shown here. 

Bottom: To read 
your feed, click the 
Favorites button (the 
star) and, at the top 
of the pone, click 
Feeds. Click the one 
you wont to read. 
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(Sometimes, in fact, the site has multiple feeds available-for example, in different 
formats-in which case you can choose among them using the " menu next to the 
RSS icon.) 

Tip: To find more RSS feeds, visit a site like www.feedster.com or www.syndicB.com. 

By the way, Internet Explorer isn't the only RSS reader. If you catch the RSS bug, you might want to try out 
a more powerful RSS reader. Visit www.downloads.com, for example, and search for RSS readers, or try a 
Web-based one like www.reoder.google.com. 

To see what the fuss is all about, click that button. Internet Explorer switches into 
RSS-viewing mode, as shown in Figure 11-9. 

At this point, you have three choices: 

• Subscribe. Click the Add to Favorites button, and then click Subscribe to This Feed. 
From now on, you'll be able to see whether the RSS feed has had any new articles 
posted-without actually having to visit the site. Figure 11-9 has the details. 

Note: Once you've subscribed to a feed, Internet Explorer checks the originating Web site once a day for 
updates. 

You can make it check a bit more obsessively, if you like (as often as every 15 minutes), or cool its jets (once 
a week). To adjust the schedule, choose Tools➔lnternet Options➔Content; click Settings at the bottom of 
the dialog box. Use the "Every:" pop-up menu to specify the frequency. 

While you're here, turn on "Play a sound" if you want a little sonic heads-up, too, when IE finds that a Web 
page you've just opened has an available RSS feed. 

• Massage the feed. Once you're looking at the feed, you can sort the headline items by 
date, title, and author, or use the Search box to find text among all the articles. 

• Close the RSS feed altogether. To do so, just click the Feeds button again. You're 
left back where you started, at whatever Web page you were visiting. 

Tip: Once you've subscribed to some feeds, you don't actually have to fire up Internet Explorer just to see 
what's new in your world. Remember the Sidebar? The Gadgets described in Chapter 7? 

One of them, you may recall, is called Feed Headlines. Yes, right there on your desktop, you'll see headlines 
from your subscribed Web sites, updating themselves as the news breaks. Click a headline to open a mini­
preview window; double-click to open Internet Explorer and view the actual Web page. 

Tips for Better Surfing 
All Versions 

Internet Explorer is filled with shortcuts and tricks for better speed and more pleas­
ant surfing. For example: 
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